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1.0: Introduction  
 
1.1 Overview of GIS Portal Toolkit  
 
GIS Portal Toolkit (GPT) provides a cost-effective way to build a functional geographic 
information system (GIS) portal quickly. ESRI's GIS Portal Toolkit is a technology and 
services solution for implementing local, regional, national, and global spatial data 
infrastructure (SDI) portals. GIS portals organize content and services such as directories, 
search tools, community information, support resources, data, and applications. They provide 
capabilities to query metadata records for relevant data and services, then link directly to the 
online sites that host content services. The content can be visualized as maps and used in 
geographic queries and analyses. Portals can also control commercial usage of services.  
 
1.1.1 What Is the ESRI GIS Portal Toolkit 3.1?  
The ESRI GIS Portal Toolkit 3.1 provides you with a site starter for your Web site and all the 
functional capabilities needed to deploy a GIS portal for your organization's SDI. The GIS 
Portal Toolkit is designed for interoperability and supports many finalized Open Geospatial 
Consortium, Inc. (OGC), specification standards.  
 
GIS Portal Site Starter—A customizable, integrated set of Web pages for setting up a GIS 
portal for your organization. The GIS portal site starter provides generic capabilities for the 
workflows needed to support SDI:  

• Search and discover metadata about GIS data and services.  
• Channel pages for organizing thematic content.  
• Online mapping.  
• User login and profile.  
• Save maps and searches.  
• Metadata management for publishers and administrators.  
• Register metadata repositories for harvesting.  

 
GIS Portal Catalog Service—Web service component for handling metadata discovery, 
publishing, and validation. The GIS portal supports public and private metadata collections. 
ISO 19115, ISO 19139 and Federal Geographic Data Committee (FGDC) metadata standards 
are supported by default in the GIS portal. Users interact with the catalog service using the 
GIS portal site starter.  
 
Map Viewer—Integrated Map Viewer that allows users to view multiple live data and map 
services in one map. The Map Viewer can connect to OGC Web Map Server (WMS), Web 
Feature Server (WFS), Web Coverage Service (WCS), and ArcIMS services. Users can share 
their maps with others, save their maps to their login account, or save the maps as an OGC 
Web Map Context (WMC) file on their local computer for reuse.  
 
Harvesting Tool—A desktop application that allows the metadata publishers to register 
metadata collections for scheduled harvesting into the GIS portal metadata catalog. The 
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Harvesting tool can harvest from ArcIMS metadata services, Z39.50, Open Archives 
Initiative (OAI), Web Catalog Service (CS-W) repositories, and Web-accessible folders.  
 
Channel Editor—A desktop application for stewards of thematic channels to select and 
organize their online content. Channels provide fast access to key information resources.  
 
Portal Toolbar for ArcMap—Provides interoperability between the GIS desktop and the 
GIS portal. When added to ArcMap, this toolbar allows users to search a GIS portal for live 
data and map services and add selected services to a map. The toolbar can also open WMC 
files created by a GIS portal Map Viewer.  
 
1.2 Intended Audience  
This document, specifically sections 2.0–4.0, is intended for those who have attended the 
ESRI GIS Portal Toolkit instructor-led class and want to install and configure ESRI GIS 
Portal Toolkit 3.1 on different operating systems than were taught in the workshop. The 
workshop only addresses Windows-based installations.  
Section 4.0 is intended for users of the desktop applications.  
 
1.3 Document Structure  

• Section 1.0—Introduction provides the background of GIS Portal Toolkit and an 
overview of the document structure. 

• Section 2.0—Environment Verification guides users through the general software 
setup sequence of the required base software and provides guidelines for ensuring a 
workable computer system for GIS Portal Toolkit.  

• Section 3.0—Windows-Based Installation guides users through the installation of 
Oracle, SQL Server, and DB2 database-based portals on the Windows operating 
system.  

• Section 4. 0— Setting Up the GIS Portal Application guides users through the 
installation of the Portal application files, and how to configure the newly installed 
portal.  

• Section 5.0—Desktop Tools Installation describes how to install the three desktop 
applications that are part of the GIS Portal Toolkit software suite.  
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2.0: Environment Verification 
 
2.1 Installing the Base Software  
This section outlines the recommended setup procedure for the required base software on 
systems that will be used to host ESRI GIS Portal Toolkit 3.1. This information is based on 
the classroom and testing environment setup the ESRI GIS portal team uses in-house.  
 
2.1.1 Software Requirements for GIS Portal Toolkit 3.1  
 
OS  

Windows 2000, Windows XP, Windows Server 2003, and Red Hat Linux 9 (Enterprise 
3.0)  
 
ESRI Software 
 ArcSDE 9.1 SP2 or ArcSDE 9.2 SP2 or higher 
 ArcIMS 9.1 SP2 or ArcIMS 9.2 SP2 or higher 
 ArcGIS 9.1 SP2 or ArcGIS 9.2 SP2 or higher  
 ArcIMS Data Delivery Extension (optional) 

ArcIMS CS-W Connector 
ArcGIS Explorer build 380 or higher (necessary for Portal Extensions) 

 
Database (one of the following) 
 DB2 8.2 
 Oracle 9i or 10g 
 SQL Server 2000 or SQL Server 2005 
 
Web Server (one of the following) 
 IIS (version dependent on Windows version) 

Apache 2.0.48 or Apache 2.0.58 
 
Servlet Connector (one of the following) 

ArcIMS 9.1 and ArcSDE 9.1 systems require Tomcat 5.0.28  
ArcIMS 9.2 and ArcSDE 9.2 systems require Tomcat 5.5.17 

 
Java (one of the following) 
 ArcIMS 9.1 and ArcSDE 9.1 systems require j2sdk1.4.2_06  

ArcIMS 9.2 and ArcSDE 9.2 systems require j2sdk1.5.0_06 
 
* All ESRI software must have the same level of service pack installed. For example, if you 
have SP3 installed on ArcIMS, you must also have SP3 on ArcSDE and ArcGIS. 
 

 Tip: Servlet Connectors (Tomcat) and Java (JDK) versions must correspond to the 
support level associated with the ArcIMS and ArcSDE versions on your system. 
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2.1.2 Recommended Setup Order  
Correct installation of the base software on your machine is the first step toward setting up a 
successful portal. The following steps show you the order in which you must install the base 
software.  
 
Step 1: Set Up the Database  

• Install SQL Server 2000 or 2005 with full text search capabilities (demands a custom 
install of SQL Server), Oracle9i (9.2.0.1+), Oracle 10gR2 (10.2.1.2), or DB2 8.2.  

• Restart your computer (may be required for certain database installs).  
• Install any service patches for the DBMS.  

 
Notes  

• Keep track of the passwords for database access for the various administrative users.  
• Install SQL Server with mixed authentication.  
• Install SQL Server with the Full Text Search option.  
• Oracle System Identifier (SID) Database instance name: ____________  
• When installing DB2 on your machine, ensure that you have a C++ compiler installed 

as well.  
• In the ESRI Learning Center, a single machine is set up and ghosted, mirroring this 

configuration on other machines. After ghosting, the machines are disconnected from 
the network. They become pure stand-alone systems.  

 
Step 2: Install ArcSDE  

• Install ArcSDE. 
• Apply any applicable patches.  
• Run the ArcSDE post-install 
 

Step 3: Install HTTP Server 
• Install IIS or Apache 2.0.48 (for 9.1) and 2.0.58 (for 9.2). 
 

Step 4: Install Java 2 SDK 1.4.2 (or higher) 
• Install j2sdk1.4.2_06 or higher in C:\j2sdk142.  
 

Step 5: Install Tomcat – NOTE: ensure that there are no spaces or periods in the filepath!  
• Install Tomcat 5.0.28 (for 9.1) in C:\Tomcat5028.  
• Install Tomcat 5.5.17 (for 9.2) in C:\Tomcat5517 
• Add Tomcat as a Windows NT service during install.  

 
Step 6: Install ArcIMS  

• Add the following components to the default ArcIMS install: Java Connector, CS-W 
connector,  

• Apply any applicable patches.  
• Run the ArcIMS post-install 
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Notes  
• Both the servlet and Java Connector must be installed.  
• Install Gazetteer Data with ArcIMS if running ArcIMS 9.1.  For ArcIMS 9.2, 

gazetteer data comes on a separate media CD 
• Optional connectors are Z39.50, and OAI.  

 
Step 7: Install ArcEditor Single Use or Higher  

• Install ArcEditor single use or higher.  
• Apply any applicable patches.  

 
Note: ArcEditor is used for cleaning and accessing the ArcSDE database. It has been noticed 
that the Metadata Services may not always be created and, thus, created tables need to be 
removed. You need ArcEditor level for this.  
 
Level of Effort  
 
Estimated time to set up the system:  

• SQL Server on Windows: 4–6 hours 
• Oracle on Windows: 7–9 hours  
• DB2 on Windows: Up to two days 
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2.2 Environment Verification 
 
The purpose of this section is to ensure that the software installation requirements of the 
ESRI GIS Portal Toolkit have been met. The ESRI GIS Portal Toolkit makes use of several 
third-party technologies, which you need to have available and running, in addition to 
ArcIMS and ArcSDE. Doing a system verification is very important when you are working 
with a client's system. 
 
As part of the environment verification (section 2.2.1), you will also start preparing your 
system to host the GIS portal. Included in this section is setting up supporting ArcIMS image 
services (section 2.2.2) for your GIS Portal Toolkit. 
 
2.2.1 Installation and Verification 
 
Step 1: Set the Regional and Language Options (Non-U.S. Computers Only) 
 
In this guide, you will install ESRI GIS Portal Toolkit on a system that utilizes the U.S. 
English settings. Differences between the United States and other countries include the use of 
commas as the decimal separator instead of the decimal point. To change/verify your 
regional settings: 
 

 Open the Control Panel. Start>Settings>Control Panel>Regional and Language 
Options (see image below).  
 

 Set the Standards and formats to English (United States). 
 

 Click OK. 
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Figure 2-1 
Regional and Language Options 

 

 
 

If you are using non-Germanic languages on your computer, ensure that you have 
the UTF-8 module installed with your database. 
 

 
Step 2: Verifying Availability of ArcSDE and the Database 
 
In the following steps, you will verify that the ArcSDE environment is installed and interacts 
with your database. 
 

 Start ArcCatalog. 
 

 Create a new Spatial Database Connection to the SDE database (default parameters: 
port 5151, Username sde, and Password sde). 

 
 Click “Test Connection”. A box that says “Connection succeeded” should pop up. 

Click “OK”. Click “OK” again to establish the spatial database connection. Double 
Click on the connection and type in a new meaningful name for it. 

 
 If the “Test Connection” does not succeed, then there may be a problem in either the 

password/username in the account authentication details in the proceeding Spatial 
Database Connection dialogue box, or there is a problem with the database itself. 

 
 When you have a successful test connection, close ArcCatalog. 
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You can use the SDEMON command to check if SDE is up and running. 
 

 Open the command console: Start>Run>cmd 
 

 Type the following command, omitting the brackets and carrots to put in the name of 
your service and your own server’s name (if you have problems, try your IP address): 
sdemon -o status   [-i <service>] [-s <server_name>] 

 
• Example: sdemon –o status –i esri_sde –s yourServersName 

 
Successful results will look similar to this: 
 

ArcSDE Instance <service> Status on <server_name> at Thu Apr 05 15:12:50 2007 
------------------------------------------------------------------------- 
Server Connection Mode:         Accepting Connections 
Active Server Processes:        0 

 
 If your results are not successful, your service may not be turned on. Go to “Services” 
(Start>Control Panel>Administrative Tools> Services) and make sure that the “Status” of the 
“ArcSde Service(servicename)” says “started”. If it does not, highlight that service and click 
“start the service” to the left. Try the SDEMON command again. 

 
Step 3: Verifying Availability of the ArcIMS Site 
 
In this first step of the environment verification, you will do a series of tests that ensure that 
the ArcIMS environment is properly configured. 
 
Verify your Server 

 Start Internet Explorer. 
 Type "http://localhost" in the address bar.  

 
You will see either an Internet Information Server (IIS) welcome message or an Apache 
welcome message. 
 
Verify your Servlet 

 Type "http://<machine name>/servlets-examples/servlet/HelloWorldExample". This 
tests if the servlet is running properly under IIS or Apache. If your servlet is running 
properly under IIS or Apache, you should see a message like the one below. 
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If you do not see this message, then there is a problem with your servlet.  Double check that 
you have configured the servlet correctly (for example, if you use Tomcat, that you’ve 
followed installation instructions, see the following help article: 
http://support.esri.com/index.cfm?fa=knowledgebase.techArticles.articleShow&d=31252 ). 
 
For Oracle Database Users 

If you are running the Web server and Oracle on the same machine, you may want to 
change the default port of the Tomcat servlet. The default port is 8080. Oracle often uses its 
own HTTP server, which runs on port 8080 as well and causes issues when configuring the 
portal.  
 

To change the default Tomcat port 
 

 Open Windows Explorer. 
 

 Navigate to the <tomcat installation directory>\conf (e.g., C:\Tomcat5028\conf). 
 

 Open the Server.xml file in notepad or an XML editor program. 
 

 Find the text: <Connector port="8080" maxThreads="150" minSpareThreads="25" 
maxSpareThreads="75" enableLookups="false" redirectPort="8443" 
acceptCount="100" debug="0" connectionTimeout="20000" 
disableUploadTimeout="true" /> 

 
 Change the port number to 8081 or 8181 (e.g., <Connector port=”8181”). 

 
 Save the file and exit. 

 
 Restart Tomcat. 

 
If you have properly configured ArcIMS with the redirector, you can omit the port 

number. The portal can run properly without the port number specified. Keep in mind that 
port numbers also need to be removed in the various properties files. 

 
Verify ArcIMS Installation and CS-W Connector Deployment 
The CS-W Connector is used by the Portal Toolbar for ArcMap. This toolbar allows you to 
search any CS-W catalog. By default, the GIS Portal uses the ArcIMS CS-W Connector.  
 

 Verify that the ArcIMS Java Connector and Servlet Connectors are installed:  
Start> Control Panel>Add or Remove Programs>ArcGIS ArcIMS>Change.  
 

 Select the Modify button. 
 

 Click Next. 
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 Follow the steps below to verify the installation of ArcIMS  and the CS-W connector 
based on the version running on your machine: 

 
ArcIMS 9.1 systems:  

 
 Click the plus sign to the left of ArcIMS Application Server Connector   

 
The following connectors must be installed: 

• Java Connector (used for authentication) 
• Servlet Connector (used for GIS Portal administration) 

 

 
 

 Click the plus sign to the left of Metadata. The following connectors 
should be installed: 

• CS-W Connector (used for Portal Toolbar) 
• Z39.50 (optional) Connector 
• Gazetteer Data (required when you set up a gazetteer service) 

 Tip: If there is an x to the left of the name, the connector has not been 
installed. To install the missing server connectors, select the connector and 
follow the installation instructions. You need to run the post-installation of 
ArcIMS again.  
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ArcIMS 9.2 systems:  
 

 Click the plus sign to the left of Server Components. 
 

The following connectors must be installed: 
• Servlet Connector (used for GIS Portal administration) 

 

 
 

 Click the plus sign to the left Metadata Solutions. The following 
connectors should be installed: 

 
• CS-W Connector (used for Portal Toolbar) 
• Z39.50 (optional) Connector 
• Gazetteer Data (required when you set up a gazetteer service) 

 

 Tip: If there is an x to the left of the name, the connector has not been 
installed. To install the missing server connectors, select the connector and 
follow the installation instructions. You need to run the post-installation of 
ArcIMS again. 

 
Running Diagnostics for Both ArcIMS 9.1 and 9.2 Systems 
NOTE: Internet Explorer 7.0 will not properly display diagnostics, so you need to use an 

alternate browser (like IE 6.0 or Firefox). Also, you will need to allow popups for 
these tests. 

 
 Open the ArcIMS diagnostics: 

Start>Programs>ArcGIS>ArcIMS>Diagnostics. 
 Click Check ArcIMS Servlet Connector. 
 Click Check ArcIMS Application Server. 
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Both tests should return a message Test Successful. If the test is not successful, consult the 
error message and update the ArcIMS installation.  

 
After Running the Diagnostics 
Now that ArcIMS is installed and functional, you will create services to verify that you can 
generate an ArcIMS service. 
 

 Open ArcIMS Administrator: Start>All Programs>ArcGIS>ArcIMS>Administrator. 
 

 Enter your user name and password, for example admin / admin.  
 

 Click the Services link in the table of contents, or the Services Manager button in the 

toolbar.  
 

 Create an image map service called SearchMap. To do this: 
 

o Click the New Service button.  
 

o Type "SearchMap" in the Name field. 
 

o For the map file field, navigate to the searchmap.axl file  
ArcIMS 9.1: C:\ArcIMS\Axl\Metadata\searchmap.axl 
ArcIMS 9.2: C:\Program 
Files\ArcGIS\ArcIMS\Samples\MetadataServices\searchmap\SearchMap.axl 
 

o Click the Virtual Server drop-down menu and select ImageServer1.   
 

o Click OK. 
 

 
Step 4: Create and Verify Your Metadata Services 

 Tip: Use the “Creating and Using Metadata Services” document from ESRI, available in 
your ArcIMS installation Help File, under the “Metadata” Content Heading. 
 
SQL Server users should start at page 2-12. 
 
For Oracle Database Users 
In the following steps, you will create a test metadata service using the SDE user. To do this: 
 

 Open the C:\ArcIMS\Axl\Metadata\MetadataServer.axl file in Notepad. 
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 Update the following text to match your machine's configuration: 
 
<SDEWORKSPACE name="sde0" server="<your machine name>" 
instance="port:5151" database="" user="sde" password="<sde password>" /> 
 
Note: If you are running your database on another port, update the port accordingly.  

 
 Click Save and exit the MetadataServer.axl file. 

 
 Open ArcIMS Administrator.  

Start>All Programs>ESRI>ArcGIS>ArcIMS>Administrator. 
 

 Choose the Service menu and select New. 
 

 Enter the Service Name imsmetadata.  
 

 Enter the Source AXL File (e.g., C:\ArcIMS\Axl\Metadata). 
 

 Select the Virtual Server from the drop down menu (e.g., MetadataServer1). 
 

 Save the ArcIMS Site configuration and exit Administrator. File> Save 
Configuration. 

 
 Ensure that all required tables for the metadata server are in place.  

 
• Open the Oracle Enterprise Manager console. Start>All Programs>Oracle- 

OraHome92>Enterprise Management Console. 
• Log in to Oracle. 
• Click the drop-down menu and select sysdba. 
• In the left window, expand the “Network” node, then the “Databases” 

node, and then the node for your database.  Expand the “Schema” node. 
• Open the SDE schema, and expand “Tables”. 
• Verify that the following tables exist under the Tables folder: 

 
 IMSMETADATA 
 IMSMETADATAD 
 IMSMETADATADR 
 IMSMETADATAR 
 IMSMETADATAU 

 
• Log out. 
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For SQL Server Database Users 
In the following steps, you will create a test metadata service using the SDE user. To do this 
you will first verify that there is a Full-Text Catalog called SDE_DEFAULT_CAT in SQL 
Server. 
 
Before you can verify or add this Full-Text Catalog, you must ensure that you have installed 
SQL Server with Full-Text Search capability correctly. To check this for ArcGIS 9.2, go to 
this link: http://webhelp.esri.com/arcgisdesktop/9.2/index.cfm?TopicName=Configuring a 
database to support text indexing and follow the instructions.  To check this for ArcGIS 9.1, 
go to the “Creating and Using Metadata Services” pdf file in the Documentation\Other folder 
on the CD, and see the section on “Configuring ArcSDE for SQL Server.”  If you do not 
have Full-Text Search capability, then uninstall SQL Server and reinstall it with the 
capability. 
 
To check for and add the SDE_DEFAULT_CAT Full-Text Catalog in SQL Server: 
 

 First, it is necessary to ensure that the database is enabled for full-text in order to 
avoid problems depending on how the database was created. Open SQL Server 
Enterprise Manager, click on “Databases” in the left navigation window to expand it, 
and open the “sde” database.  Check if there is an icon for the Full-Text Catalog. 

 
 Check to see if the SDE_DEFAULT_CAT is present. In SQL Server 2005, you will 

need to expand the “Storage” folder and then the “Full-Text Catalog” folder to see 
this. 

 
 If the full-text catalog SDE_DEFAULT_CAT is not present, you must add it. Do the 

following: 
•  Under the sde database folder, navigate to the Full-Text Catalog folder 

and right click.  Select “New Full Text Catalog”. 
• Provide ‘SDE_DEFAULT_CAT’ as the full-text catalog name.  
• Click OK. 

 
 Close SQL Server Enterprise Studio (2000) or Management Studio (2005) 

 
In the following steps, you will create a test metadata service using the sde user. To do this: 
 

 Open the C:\ArcIMS\Axl\Metadata\MetadataServer.axl file in Notepad. 
 

 Update the following text to match your machine's configuration: 
 
<SDEWORKSPACE name="sde0" server="<your machine name>" 
instance="port:5151" database="sde" user="sde" password="<sde password" /> 
 
Note: If you are running your database on another port, update the port accordingly.  
 

 Save your file and close Notepad. 
 



 
2.0:  Environment Verification Installation Guide for GIS Portal Toolkit 3.1 

 
 

 
 

October 2007 2-13 
 

 Open ArcIMS Administrator.  
Start>All Programs>ESRI>ArcGIS>ArcIMS>Administrator. 

 
 Create a metadata service called imsmetadata that points to the MetadataServer.axl 

file. 
 

 Save the ArcIMS Site configuration and exit Administrator. File>Save Configuration. 
 

 Ensure that all required tables for the metadata server are in place. 
 

• Open SQL Server Enterprise Manager (2000) or Management Studio (2005). 
• Open the sde database. 
• Navigate to the tables and verify that the following tables exist: 
 

 IMSMETADATA 
 IMSMETADATAD 
 IMSMETADATADR 
 IMSMETADATAR 
 IMSMETADATAU 

 
• Log out. 

 
Step 5: Verify Data Delivery Extension Installation (Optional) 
 
As an optional feature, ESRI ArcIMS Data Delivery extension can be used with the GIS 
Portal Toolkit. The GIS Portal Toolkit can operate without the Data Delivery extension. To 
verify that the Data Delivery extension is installed on your machine, please check the 
following: 
 

 Open a Web browser. 
 

 Type in the following URL: "http://<Machine 
name>/safeViewerHTML/indexmap.html" 
 
o A map is displayed. 

 
This test only verifies that the Data Delivery extension is working; it does not inform you 
which layers have been loaded. Below is a second test you can conduct: 
 

 Type in the following URL: 
"http://<machine_name>/Scripts/DDE/spatialDirect.pl?SSFunction=prepareFetch" 

 
o The order data form is displayed. 
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Note: Update the above URL accordingly if you have different CGI script root 
directory (in this example ‘Scripts’) and/or subdirectory name for DDE-specific 
CGI script files (in this example ‘DDE’). 

 
 
The Data Delivery extension requires a separate install. For installation instructions, see the 
Data Delivery extension installation guide. 
 
Step 6: Download ArcGIS Explorer 
 
ArcGIS Explorer is a freely downloadable lightweight client for ArcGIS Server. It can be 
used to access, integrate, and utilize GIS services, geographic content, and other Web 
services. It can also be used in conjunction with a “Find Services” tool provided in Exercise 
10 to locate and view metadata records, and preview the metadata on a digital globe.  
 

 Go to http://www.esri.com/software/arcgis/explorer/index.html and click the link on 
the main menu under the “Free Download” heading that says “Download ArcGIS 
Explorer”.   

 
 If you have an ESRI global account, you will need to use it to login on the next page. 

If you do not have an ESRI global account, you will need to create one, and then 
login. 

 
 After logging in, you will be directed to a page where you can download ArcGIS 

Explorer. Click on the “Download ArcGIS Explorer” button. 
 

 Save the file, and then run the installation by double-clicking 
“ArcGISExplorerDownload.exe”. 

 
 Follow the instructions in the installation wizard. 

 
 Open the ArcGIS Explorer application to verify that it is installed and runs. 

 
 
Step 7: Verifying Availability of Third-Party Technologies 
 
Please ensure that the technologies listed below (table 2-1 at the end of this chapter) are 
available for this workshop. You may want to store them in temporary folders that you create 
on your computer, for example: 
 

 Portal library files can be stored in C:\temp\Portal\lib 
 Map Viewer library files can be stored in C:\temp\MapViewer\lib 

 

 Tip: Some of these technologies require that you obtain a license, even when they are 
offered free of charge or as open source. When your portal implementation is delivered to 
clients, they will have to do the same with respect to obtaining these technologies. 
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If you have checked the availability of all the technology requirements listed in table 2-1, you 
are ready to start installing ESRI GIS Portal Toolkit. 
 

 Tip: In addition to the above-mentioned required software components, you may want to 
download DB Visualizer as well. This is a tool that can help you troubleshoot Java Database 
Connectivity (JDBC) connections. You can download the DB Visualizer application from the 
following URL:  http://www.dbvis.com/products/   
 
 
2.2.2 Setting Up Supporting Map Services 
 
The GIS Portal and the Map Viewer rely on different map services to support data searches 
and view maps. In this step, you will set up three map services (table 2-2) that the GIS Portal 
and the Map Viewer will use.  
 
Below are the instructions for creating map services during the Portal Toolkit training class. 
The training class provides map service files and data showing a map of the world. For your 
own installation, select the data most appropriate for your portal. You can use AXL or MXD 
files for your services. 

Table 2-2 
Supporting Map Services for the Portal Toolkit 

 
Service Name Source AXL File Service Type 

PortalSearchMap PortalSearchMap.axl Image Service 
PortalBaseMap PortalBaseMap.axl Image Service 

PortalAcetateMap  PortalAcetateMap.axl Image Service 
 

 Create three AXL files according to the specifications in the table above using 
ArcIMS Author. Follow the guidelines and steps below.  

 Files to create in Author: 
• PortalSearchMap.axl: this map will constitute the IMS map users see 

when the open the search page. Example data layers you could use in this 
map: 

• A background grid coordinate system layer 
• World country polygons 
• World administrative boundaries 
• Major rivers of the world 
 

• PortalBaseMap.axl: this map will constitute the IMS map users see when 
they open the MapViewer. Example data layers you could use in this map: 

• A background grid coordinate system layer 
• World country polygons 
• World administrative boundaries 
• Major rivers of the world 
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• PortalAcetateMap.axl: this map is used to hold acetate layers in the 
mapping services, such as north arrows and scalebars. Example data layers 
you could use in this map: 

• A background grid layer. 
 

 Create the corresponding ArcIMS services. Open ArcIMS Administrator, select: 
Start>All Programs>ESRI>ArcGIS>ArcIMS>Administrator. 

 Login to ArcIMS Administrator with your User name and Password, for example 
admin/admin. 

 Create the three image services as specified above. For example:  
 

• Enter the Service Name: PortalSearchMap 
• Select the Browse button  to locate the Map File, or Source AXL File, 

on your machine (e.g., C:\ArcIMS\Axl\PortalSearchMap.axl). 
• Select the Virtual Server from the drop down menu as ImageServer1 

 
Repeat this process to create image services for the PortalBaseMap.axl and the 
PortalAcetateMap.axl files. 
 

 Save your configuration. 
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Table 2-1 
Third-Party Libraries 

  Vendor JAR Version 
Shipped 

With Location 
  Portal - Database Libraries     
1 Oracle 9i /10g JDBC Driver ojdbc14_g.jar 9i/10g Oracle <Oracle installation directory>\<OraHome>\jdbc\lib  

2 
IBM DB2 driver db2jcc.jar 1.3.1 IBM 

http://www-
128.ibm.com/developerworks/db2/downloads/jcc/inde
x.html 

3 
IBM DB2 driver db2jcc_license_cu.jar 1.3.1 IBM 

http://www-
128.ibm.com/developerworks/db2/downloads/jcc/inde
x.html 

4 SourceForge JTDS jtds-1.2.2.jar 1.2.2 Download http://sourceforge.net/project/showfiles.php?group_id
=33291&package_id=25350&release_id=534076 

  Portal - Other Libraries     

5 
Apache Axis axis.jar 1.2.1 Download http://archive.apache.org/dist/ws/axis/1_2_1/axis-bin-

1_2_1.zip 

6 
Apache Axis axis-ant.jar 1.2.1 Download http://archive.apache.org/dist/ws/axis/1_2_1/axis-bin-

1_2_1.zip 

7 
Apache Axis jaxrpc.jar 1.2.1 Download http://archive.apache.org/dist/ws/axis/1_2_1/axis-bin-

1_2_1.zip 

8 
Apache Axis log4j-1.2.8.jar 1.2.8 Download http://archive.apache.org/dist/ws/axis/1_2_1/axis-bin-

1_2_1.zip 

9 
Apache Axis saaj.jar 1.2.1 Download http://archive.apache.org/dist/ws/axis/1_2_1/axis-bin-

1_2_1.zip 

10 
Apache Axis wsdl4j-1.5.1.jar 1.5.1 Download http://archive.apache.org/dist/ws/axis/1_2_1/axis-bin-

1_2_1.zip 

11 
Apache Commons Beanutils commons-beanutils.jar 1.6 Download http://archive.apache.org/dist/jakarta/commons/beanut

ils/binaries/commons-beanutils-1.6.zip 

12 
Apache Commons Collections commons-collections-3.0.jar 3.0 Download http://archive.apache.org/dist/jakarta/commons/collect

ions/binaries/commons-collections-3.0.zip 

13 
Apache Commons DBCP commons-dbcp-1.2.1.jar 1.2.1 Download http://archive.apache.org/dist/jakarta/commons/dbcp/b

inaries/commons-dbcp-1.2.1.zip 

14 
Apache Commons Digester commons-digester.jar 1.5 Download http://archive.apache.org/dist/jakarta/commons/digest

er/binaries/commons-digester-1.5.zip 

15 
Apache Commons Discovery commons-discovery.jar 0.2 Download http://archive.apache.org/dist/jakarta/commons/discov

ery/binaries/commons-discovery-0.2.zip 
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  Vendor JAR Version 
Shipped 

With Location 

16 
Apache Commons Fileupload commons-fileupload-1.0.jar 1.0 Download http://archive.apache.org/dist/jakarta/commons/fileupl

oad/binaries/commons-fileupload-1.0.zip 

17 
Apache Commons Lang commons-lang-2.0.jar 1.0.1 Download http://archive.apache.org/dist/jakarta/commons/lang/b

inaries/commons-lang-2.0.zip 

18 
Apache Commons Logging commons-logging.jar 1.0.3 Download http://archive.apache.org/dist/jakarta/commons/loggin

g/binaries/commons-logging-1.0.3.zip 

19 
Apache Commons Pool commons-pool-1.2.jar 1.2 Download http://archive.apache.org/dist/jakarta/commons/pool/b

inaries/commons-pool-1.2.zip 

20 
Apache Commons Validator commons-validator.jar 1.0 Download http://archive.apache.org/dist/jakarta/commons/validat

or/old/v1.0/validator-1.0.zip 

21 
Apache Struts struts.jar 1.1 Download http://archive.apache.org/dist/jakarta/struts/binaries/ja

karta-struts-1.1.zip 

22 
Apache Velocity velocity-dep-1.3.1.jar 1.3.1 Download http://archive.apache.org/dist/jakarta/velocity/velocity

-1.3.1/velocity-1.3.1.zip 

23 
Apache Xalan xalan.jar 2.7 Download http://apache.osuosl.org/xml/xalan-j/xalan-j_2_7_0-

bin.zip 

24 
Apache Xalan xercesImpl.jar 2.7 Download http://apache.osuosl.org/xml/xalan-j/xalan-j_2_7_0-

bin.zip 

25 
Apache Xalan xml-apis.jar 2.7 Download http://apache.osuosl.org/xml/xalan-j/xalan-j_2_7_0-

bin.zip 

26 
Sun JAF activation.jar 1.1 Download http://java.sun.com/products/javabeans/jaf/downloads/

index.html 

27 
Sun JavaMail mail.jar 1.2 Download http://java.sun.com/products/javamail/downloads/inde

x.html 

28 
Unknown junit.jar 1.4 Download http://java.freehep.org/jcvslet/JCVSlet/zip/freehep/fre

ehep/tools/tools.zip 

21 
Apache Struts struts.jar 1.1 Download http://archive.apache.org/dist/jakarta/struts/binaries/ja

karta-struts-1.1.zip 
 Portal – Other Libraries – provided with ArcIMS installation    

29 ESRI arcims_jconnect.jar 1.0 ArcIMS 
9.1. & 9.2 

C:\Program 
Files\ArcGIS\ArcIMS\Administrator\esriadmin\WEB-
INF\lib 

 Portal – Other Libraries – provided with Portal installation    
30 ESRI esri-translator.jar  Portal Needed for ISO 19139 -> ESRI ISO translation 

31 
ESRI isglobal.jar 1.0 Portal Developed by ESRI (Geographynetwork), not 

required when not connecting to GN 
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  Vendor JAR Version 
Shipped 

With Location 
32 ESRI jxcb.jar  Portal Developed for the GPT 
            
  Map Viewer - Database Libraries 
1 Oracle 9i/10g JDBC Driver ojdbc14_g.jar 9i/10g  Portal/WEB-INF/lib 
2 IBM DB2 driver db2jcc.jar 1.3.1  Portal/WEB-INF/lib 
3 IBM DB2 driver db2jcc_license_cu.jar 1.3.1  Portal/WEB-INF/lib 
4 SourceForge JTDS jtds-1.2.2.jar 1.2.2  Portal/WEB-INF/lib 
  Map Viewer Drivers that can be copied from the Portal lib folder (Portal/WEB-INF/lib)  
5 Apache Axis log4j-1.2.8.jar 1.2.8   Portal/WEB-INF/lib 
6 Apache Commons commons-collections-3.0.jar 3.0  Portal/WEB-INF/lib 
7 Apache Commons commons-fileupload-1.0.jar 1.0   Portal/WEB-INF/lib 
8 Apache Commons commons-dbcp-1.2.1.jar 1.2.1   Portal/WEB-INF/lib 
9 Apache Commons commons-pool-1.2.jar 1.2  Portal/WEB-INF/lib 

10 Apache Xalan xercesImpl.jar 2.7   Portal/WEB-INF/lib 
11 Apache Xalan xml-apis.jar 2.7    Portal/WEB-INF/lib 
  Map Viewer drivers on your local machine        

12 
Sun Microsystems jai_core.jar 1.4 (or 

higher) 
  C:\Program Files\Java\jre1.5.0_06\lib\ext 

13 
Sun Microsystems jai_codec.jar 1.4 (or 

higher) 
  C C:\Program Files\Java\jre1.5.0_06\lib\ext 

  Map Viewer drivers that you must download        

14 
Apache Batik batik-awt-util.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

15 
Apache Batik batik-bridge.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

16 
Apache Batik batik-css.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

17 
Apache Batik batik-dom.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

18 
Apache Batik batik-ext.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

19 
Apache Batik batik-extension.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 
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  Vendor JAR Version 
Shipped 

With Location 

20 
Apache Batik batik-gvt.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

21 
Apache Batik batik-parser.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

22 
Apache Batik batik-script.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

23 
Apache Batik batik-svg-dom.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

24 
Apache Batik batik-transcoder.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

25 
Apache Batik batik-util.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 

26 
Apache Batik batik-xml.jar 1.6 Download http://www.eu.apache.org/dist/xmlgraphics/batik/batik

-1.6.zip 
 Map Viewer Libraries - Distributed with Portal        
27 ESRI esriCWebDbAuth.jar   Portal   
28 ESRI iscore.jar   Portal   
29 ESRI isother.jar   Portal   

 
 
End
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3.0: Windows-Based Portal Database Installation 
 
The purpose of this section is to ensure that the GIS Portal database is properly installed and 
configured.  

 
SQL Server users, please skip ahead to section 3.2 page 3-15 titled “Database 
Installation for SQL Users.” 

 
 
3.1 Database Installation for Oracle Users 

 
Steps 1 & 2 below are for new GPT 3.1 installs only.  If you are migrating an 
existing GPT 3.0 database to GPT 3.1, skip to Step 3. 

 
 
Step 1: Setting Up the Table Space 
 
If you have an existing instance of the meta database that you no longer wish to keep, please 
delete this schema before running the new scripts. 
 

 Delete the TOOLKIT_META tables from the old install using ArcCatalog. 
 

 Delete the meta schema using the Oracle Enterprise Manager: 
Click Security>Users and delete the META user. 

 
 Click Storage and delete the PTK table space. 

 
Failure to do the above may result in your not being able to create metadata services. 
 

 Open the command console (Start>Run>cmd) 

 Tip: In the following commands, be sure to include the semicolons. 
 

 sqlplus /nolog 
 

 SQL>connect sys/sys as sysdba;  
 

 SQL>create tablespace ptk datafile 'C:\oracle\oradata\ptk.dbf' size 500M; 
 

 SQL>create user meta identified by meta default tablespace ptk temporary tablespace 
temp; 

 
 SQL>commit; 

 
 SQL>quit. 
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Step 2: Setting Up the Database Schema (New GPT 3.1 installs only!) 
 
Database setup uses two scripts that are independent of the system user. The scripts are: 

o Grants.cmd—This script sets the user permissions for the create meta database. 
 
o Create_toolkit_Schema.cmd—This script creates the table structure and triggers and 

populates tables in the meta schema. 
 
The scripts are located in <CDROM>\Supporting Files\Database Scripts\Oracle. Copy them 
to a location on your machine, because they will need to be edited. 
 
Running Grants.cmd 
 

 Inside the local directory where you have saved the files, right-click the script 
grants.cmd file and select Edit. 

 
 Edit the following line to match your sys user, meta user, and sde user: 

SQLPLUS/nolog @Grants.sql sys_username sys_password meta_username 
sde_username  >>  grants.txt 

 
Syntax of the @Grants.sql.cmd 

o Sys_username—Oracle database sys user name. Default = sys 
o Sys_password—Password of the Oracle database sys user. Default = sys 
o Meta_username—The user name of the main meta schema owner. Default = meta 
o Sde_username—The user name of the SDE user. Default = sde 
 

 Save the file. File>Save. 
 

 Open a command prompt window. Start>Run>cmd 
 

 Navigate to the directory where you have saved the edited file, for example you can 
enter “cd C:\Data\Database Scripts\Oracle”. 

 
 Run the grants.cmd file from the command prompt window by typing "grants.cmd". 

 
 Review the grants.txt file and ensure that you do not get any insufficient privileges 

messages.  
 

Do not proceed if you received any errors in your grants.txt file. Fix the errors 
first! 

 
Running Create_Toolkit_Schema.cmd 
 
The create_toolkit_schema script will create the necessary tables in Oracle to support the 
Portal application.  Run this script if you are installing a new instance of the Portal, or have 
started with a clean database.  If you run this script on top of an existing Portal installation, 
you will overwrite your existing Portal database! 
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 Inside the directory where you saved the files for editing, right-click the file 

create_toolkit_schema.cmd and select Edit. 
 

 Edit the following line to match your settings:  
SQLPLUS/nolog @Create_toolkit_schema.sql meta_username meta_password 
sde_username >> Toolkitschema.txt 

 
Syntax of the @create_toolkit_schema.sql statement: 

o Meta_username—The user name of the main meta schema owner. Default = meta 
o Meta_password—The password of the meta user. Default = meta 
o Sde_username—The user name of the SDE user. Default = sde 
 

 Save the file. File>Save. 
 

 Open a command prompt window. Start>Run>cmd. 
 

 Navigate to the directory where you have saved the edited file, for example you can 
enter “cd C:\Data\Database Scripts\Oracle”. 

 
 Run the create_toolkit_schema.cmd file from the command prompt window by typing 

"create_toolkit_schema.cmd". 
 

 Review the create_toolkit_schema.txt file and ensure that you do not get any error 
messages. Error messages and a warning stating that Table or view does not exist can 
be ignored. It simply means that the script was trying to delete a nonexistent table. 

 
Running the Create_Thesaurus_Util.cmd Script 
 
The next set of scripts sets up a thesaurus in your Oracle installation for use with the Portal. 
 
The scripts are located in <CDROM>\Supporting Files\Database Scripts\Oracle\thesaurus. 
Copy them to a location on your machine, because they will need to be edited. 
 

 Inside the directory where you have saved your file for editing, right-click the file 
Create_Thesaurus_Util.cmd and select Edit. 

 
 Edit the following line to match your settings:  

SQLPLUS/nolog @Create_Thesaurus_Util.sql meta_username 
meta_password@OracleSID >> Create_Thesaurus_Util.txt 

 
 Save the file. File>Save. 

 
 Open a command prompt window. Start>Run>cmd. 

 
 Navigate to the directory where you have saved the edited file, for example you can 

enter “cd C:\Data\Database Scripts\Oracle\thesaurus”. 
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 Run the create_thesaurus_util.cmd file from the command prompt window by typing 

"Create_Thesaurus_Util.cmd". 
 

 Review the Create_Thesaurus_Util.txt file and ensure that you do not get any error 
messages that deal with insufficient permissions.  

 
Note:  The Oracle SID is a required entry. If you run this script remotely, the correct syntax 
will also include the machine name after the SID and an underscore: <sid>_<Oracle Server>. 
 
Load the Thesaurus Data 
 

 Inside your file directory, right-click the file LoadThesaurus_Test.cmd and select 
Edit. 

 
 Edit the following line to match your users:  

ctxload -thes -user meta/meta@OracleSID -name Thesaurus_Test -file 
Thesaurus_Test.txt 

 
 Save the file. File>Save. 

 
 Open a command prompt window. Start>Run>cmd. 

 
 Navigate to the directory where you have saved the edited file, for example you can 

enter “cd C:\Data\Database Scripts\Oracle\thesaurus”. 
 

 Run the LoadThesaurus_Test.cmd file from the command prompt window by typing 
"LoadThesaurus_Test.cmd". 

 
Repeat these steps for the NOAA thesaurus. 
 
 
Step 3:  GPT 3.0 to GPT 3.1 migration 
 
This step is intended only for those users who are migrating a GPT 3.0 Portal database to a 
GPT 3.1 database.   
 
Running migrate_v30v31_oracle.sql 
 
You must have an existing GPT 3.0 database in order to run this script.  It will not work with 
GPT 2.x databases.  The migrate_v30v31_oracle.sql script will update your existing GPT 3.0 
database to a GPT 3.1 database.   
 

 Open the command console (Start>Run>cmd); 
 

 sqlplus /nolog 
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 SQL>connect sys/sys as sysdba;  
 

 Run the file migrate_v30v31_oracle.sql by typing: “@migrate_v30v31_oracle.sql” 
 

 Tip: There are a few more steps involved in migrating a GPT 3.1 instance, but they 
have to be done after the GPT application is deployed, in the next section. 
 
 

Step 4: Verify Database Connection 
 
Verify that you can connect to the Portal Toolkit database using ArcCatalog. 
 

 Start ArcCatalog. Start>All Programs>ESRI>ArcGIS>ArcCatalog. 
 

 Extend the Database Connections heading in the table of contents. 
 

 Double click Add Spatial Database Connection to create a new spatial database 
connection. 
 

 Server: <your machine name>. 
 

 Service (Port) = 5151. 
 

 Enter meta for the user name (or whatever user name you specified in Step 2). 
 

 Enter meta for the password (or whatever user name you specified in Step 2). 
 

 Click the Test Connection button. 
 

 A popup box saying the connection succeeded displays. Dismiss the box. 
 

 Click OK 
 

 Verify that you can see the GIS Portal Toolkit tables in the ArcCatalog database 
connection by double-clicking on the “meta” connection. 
 

 Exit ArcCatalog. 
 

If at some point during the installation the database becomes corrupt and you need 
to remove your metadata tables, use ArcCatalog instead of Oracle to do so.  
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Step 5: Setting Up Metadata Services 
 
In this step, you will install and configure two metadata services required for ESRI GIS 
Portal Toolkit; these metadata services are used to browse and publish metadata. 
 

 Copy the following ArcIMS XML structure (AXL) files (below) from 
<CDROM>\Supporting files\Axl\Oracle to the C:\ArcIMS\Axl directory on your 
local computer:  
 

o toolkit_browse_metadata.axl 
o toolkit_publish_metadata.axl 

 
 Edit the SDEWORKSPACE tag in the AXL files listed above to modify the server 

name, instance, user name, and password as stated in Step 4. 
 

 
 

 In both files, verify the table prefix for the metadata services in ArcCatalog or 
ArcSDE. The current default is TOOLKIT_META.  You need to verify that this table 
prefix does not already exist in the database.  If the prefix already exists, you can 
either use a different prefix such as TOOLKIT_META1 or delete the existing 
TOOLKIT_META. 

 
<TABLE_NAME prefix="TOOLKIT_META" /> 

 
Next, create two metadata services using the ArcIMS Administrator as defined by the two 
AXL files provided. The service parameters are listed below in table 3-1. 
 

 Open the ArcIMS Administrator.  
Start>All Programs>ESRI>ArcGIS>ArcIMS>Administrator 
 

 Choose the Service menu and select New. 
 

 Enter the Service Name (e.g., TOOLKIT_Browse_Metadata).  *Note:  ArcIMS is 
case-sensitive.  Enter the service name exactly as it is specified in Table 3-1 

 
 Enter the Source AXL File (e.g., C:\ArcIMS\Axl\Toolkit_browse_metadata.axl). 

 
 Select the Virtual Server from the drop down menu (e.g., MetadataServer1). 
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 Repeat the steps above until you create a Service for both the 
TOOLKIT_Browse_Metadata and the TOOLKIT_Publish_Metadata files. 

 
  

Table 3-1 
ESRI GIS Portal Toolkit Metadata Service Names 

 
Service Name Source AXL File Service Type 

TOOLKIT_Browse_Metadata Toolkit_browse_metadata.axl Metadata Service 
TOOLKIT_Publish_Metadata Toolkit_publish_metadata.axl Metadata Service 

 

 Tip: You may not be able to create the metadata services using the defined prefix 
TOOLKIT_META. You can test setting up the metadata services in the META schema using 
a different prefix (e.g., TOOLKIT_META2). If you can create a metadata service using this 
prefix, it is safe to use the predefined prefix. 

 
 Verify that the map service names in ArcIMS Administrator match those you created 

above: TOOLKIT_Browse_Metadata and TOOLKIT_Publish_Metadata. 
 

 Save the site configuration. File>Save Configuration. 
 
The metadata service generates a root document when setting up the services. To verify that 
the configuration of the metadata services is correct, compare the DOCUUIDs of the root 
document in two locations. 
 

 Open Oracle Enterprise Manager. Start>All Programs>Oracle>Enterprise Manager 
Console 

 
 Navigate to Schema>META>Tables. 

 
 Open the TOOLKIT_META table. Right-click> View/Edit Contents. 

 
 Open the ASEARCHXMLDOC table. Right-click> View/Edit Contents. 

 
 Compare the DOCUUID for the root document. You should have the same 

DOCUUIDs in both the TOOLKIT_META table and the ASEARCHXMLDOC table. 
 

If the DOCUUID is the same in both tables, you can proceed with installation of 
GIS Portal Toolkit. If you do not have the same DOCUUIDs in both tables, you 
must remove the metadata tables using ArcCatalog and re-create the metadata 
services. If you delete the table using Oracle, then you also need to remove records 
from the SDE database and table. ArcCatalog does this for you automatically. 
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After running the create_toolkit_schema script and setting up the metadata services, a large 
number of tables have been created in the META schema. Table 3-2 below lists the created 
tables and the source of the creation (script or ArcIMS). 
 

Table 3-2 
GIS Portal Database Tables 

 

# Table Created By Description 
1 APUBLISHOUTPUTS Script Deprecated table.  Not used. 
2 APUBLISHRESULTS Script Deprecated table.  Not used. 
3 ASEARCHXMLDOC Script Table used for storing the XML 

and metadata record 
information. Main search table. 

4 JOB_TABLE Script Indexing history. 
5 TOOLKIT_ADDRESSTYPE Script Type of address specified in a 

user’s profile. 
6 TOOLKIT_CHANNELS Script Channels in the portal. 
7 TOOLKIT_CHANNELS_HISTORY Script Channel history records. 
8 TOOLKIT_CHANNELUSERS Script Channel stewards 
9 TOOLKIT_GROUP_MEMBERS Script Members of a metadata security 

policy group. 
10 TOOLKIT_GROUP_MEMBERTYPES Script Types of members of groups 
11 TOOLKIT_GROUPS Script Metadata security policy groups 
12 TOOLKIT_HARVEST_HISTORY Script History of each repository’s 

harvest 
13 TOOLKIT_HARVESTING Script Metadata repositories 
14 TOOLKIT_MAPSERV_PERM Script Stores all the individual 

authentication rules for each 
ArcIMS service. 

15 TOOLKIT_META ArcIMS Business table associated with 
the metadata service's feature 
class.  Contains one record for 
each folder or document. 

16 TOOLKIT_METAD ArcIMS Records which documents have 
been deleted from the metadata 
service. 

17 TOOLKIT_METADR ArcIMS Records which relationships no 
longer exist in the metadata 
service. 

18 TOOLKIT_METAR ArcIMS Stores the relationships between 
documents, folders, and the 
metadata service. 

19 TOOLKIT_METAU ArcIMS Stores the names of all users 
who have sent requests to the 
metadata service users. 

20 TOOLKIT_MV_COORDSYS Script List of coordinate 
systems/projections eligible to 
be used by Map Viewer. 

21 TOOLKIT_MV_LINKS Script Saved user maps created when 
saving map “as a link”. 

22 TOOLKIT_MV_SAVED Script Saved user maps. 
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# Table Created By Description 
23 TOOLKIT_MV_SERVICES Script Map services that have been 

accessed with the MapViewer. 
24 TOOLKIT_PUBPOLICY_ACCESSCODES Script The various states for setting a 

publisher’s policy. 
25 TOOLKIT_PUBPOLICY_MEMBERS Script Members of a given publisher’s 

policy 
26 TOOLKIT_SEARCHCRITERIA Script Saved user search criteria. 
27 TOOLKIT_SEL_CHNLUSERS Script Stewards for all channels 
28 TOOLKIT_USERS Script The authentication database's 

users table. The users table 
stores all the user names and 
passwords. 

29 TOOLKIT_USERS_ROLES Script The various roles a user can 
have. 

 
The preloaded default values for selected key database tables are listed at the end of this 
section. 
 
Step 6: Starting the Index Scheduler 
 
ESRI GIS Portal Toolkit 3.1 uses the native Oracle indexer to index the XML files. To 
ensure that your database is up-to-date, you must execute a process (job) to run the indexer 
periodically. ESRI accomplishes this using a stored procedure. Follow these steps to start this 
procedure: 
 

 Open the command console, Start>Run>cmd 
 

 sqlplus /nolog 
 

 SQL> connect meta/meta 
 

 Exec job_call 
 

 SQL>quit 
 
If the job call returns an error during startup, you may need to compile the stored procedure.  
 
Follow these steps to verify what needs to be compiled: 
 

 Open Enterprise Manager. Start>All Programs>Oracle>Enterprise Manager Console 
 

 Schema>Meta>Sequences. 
 

 Compile any sequence that has a red icon to the left of the name. Right-click> 
Compile. 
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Step 7: JDBC Authentication (Esrimap_Prop) 
 
As part of setting up the metadata services for ESRI GIS Portal Toolkit, the Esrimap_prop 
file must be modified to work with JDBC connectors. 
 

 Open the Esrimap_prop file in Notepad, which is located in your Tomcat home 
installation (e.g., C:\<Tomcat install directory>\webapps\servlet\WEB-
INF\classes\Esrimap_prop). 

 
 Modify the file to use the JDBC permission tables. Each of the parameters below 

must be updated to the specified values.  For each parameter that is preceded with a 
“#”, you must remove this character so as to ‘uncomment’ the parameter, thereby 
enabling it. 

 
o enable=True 
o appServerMachine=<machine name> 
o appServerClientPort=5300 
o failover=False 
o debug=False 
o authenticate=True 
o authMethods=Basic 
o useJdbc=True 
o jdbcDriver=oracle.jdbc.driver.OracleDriver 
o jdbcUrl=jdbc:oracle:thin:@<Database Server Name>:1521:<Database instance 

name> 
o jdbcUser=meta 
o jdbcPassword=meta 
o jdbcPermTable=TOOLKIT_MAPSERV_PERM 
o jdbcUserTable=TOOLKIT_USERS 
o jdbcUidColumn=USERID 

 
 Save your changes. File>Save. 

 
 Copy the Oracle JDBC driver file from C:\oracle\ora92\jdbc\lib\. to <Tomcat install 

dir>\webapps\servlet\WEB-INF\lib  
 
o ojdbc14_g.jar 

 
Step 8: Gazetteer Metadata Service 
 
ESRI GIS Portal Toolkit utilizes a gazetteer service for place-name lookup and defined 
spatial search extents. In this step, you will load the gazetteer, and then create a gazetteer 
metadata service. Loading the gazetteer requires running an ArcIMS .bat command which 
references gazetteer data. You may use the default gazetteer data provided on the ArcIMS 
gazetteer CD or use data of your own.  
 
For more details, see the Creating and Using Metadata Services document. 
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Step 8a: Loading the Gazetteer  
To load the gazetteer, follow the instructions below according to your version of ArcIMS. 
 

 Go to “Services” and make sure that your ArcSDE Service (esri_sde) has been 
started.  

 
 Open the command prompt Start>Run>cmd 

 
ArcIMS 9.1:  

 
 Navigate to the location of the gazetteer import .bat file (GazetteerImport_Ora.bat), 

found at: <ArcIMS Installation Directory>\Metadata\Data\Gazetteer\ 
 

 Type "GazetteerImport_Ora <sde_server_name> <sde_instance_port> <username> 
<password>".  The script can take a while to run, so be patient. 

 
Note: The user name and password parameters reference the user who will own the 
gazetteer tables. This could be the SDE user, the meta user, or you may decide to 
separate the gazetteer data out into its own tablespace, in which case it would be your 
new “gazetteer” user.  Should you decide to create the gazetteer in its own tablespace, 
you will have to create the gazetteer tablespace and user first before running this 
command.  If this is the case, follow the instructions from Step 1, but with a new 
tablespace name and user credentials for the gazetteer user.  You will also need to run 
the grants.cmd script for this new user. 

 
 After the script finishes, check the command window output for errors.  You should 

see “successfully created index” often.  There may be a few errors related to deleting 
tables that don’t exist.  You can ignore those errors. 

 
Now that the data is loaded, you must index the tables so that the gazetteer can be searched.  
 

 Set your working directory in the command line window to the directory that houses 
the index command called “aimsmetaindx.exe”.  It is located under your <ArcIMS 
Installation Directory>\Metadata\Commands folder. 

 
 Index the gazetteer data by typing "aimsmetaindx.exe <sde_server_machine> 

<sde_instance> <database> <username> <password> {table_name_prefix} {logfile} 
{indexNew | indexAll} {localcodepage}". 
 
example: aimsmetaindx <sde_server_machine> <sde_instance> # 
<username> <password> gazetteer # # # 

 
o By default, the table_name_prefix is “gazetteer”.  Make sure that in your 

case, it is the same as the 8th parameter of the gazImport command you ran 
above. 

o The last 3 parameters are optional.  You can leave them out, or put # # # in 
their place. 
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o After the aimsmetaindx.exe file runs, it will ask you to check the log file 
to verify that all documents were successfully created.  You will find the 
log file in the “Commands” directory and the filename is 
“aimsmetaindx.log”.  The log should read something similar to “[<Date>  
<Time>] [<numbers> <numbers> INFO1] Indexed successfully” 

 
 Proceed to Step 8b. 

 
 
ArcIMS 9.2: 

 
 Navigate to the location of the gazetteer import script (gazImport.bat), found at: 

<ArcIMS Installation Directory>\Metadata\Gazetteer\ 
 
 

 Type "gazImport oracle <sde_server_name> <sde_instance_port> # <username> 
<password> # gazetteer <path to gazetteer data>".   

 
o The “#” sign indicates that you are accepting a default value, and is 

considered one of the parameters to the script. 
 
o If you are using default ArcIMS gazetteer data and you have copied it into 

the same directory as the gazImport command, the parameter for the “path 
to gazetteer data” will be “gazworld92” or “gazusa92”.  If this data resides 
elsewhere, make sure to precede the data name with the absolute path to 
the data. (i.e. C:\myData\gazetteerData\gazworld92) 

 
o The script will take awhile to run, so be patient. 

 
Note: The user name and password parameters reference the user who will own the 
gazetteer tables. This could be the SDE user, the meta user, or you may decide to 
separate the gazetteer data out into its own tablespace, in which case it would be your 
new “gazetteer” user.  Should you decide to create the gazetteer in its own tablespace, 
you will have to create the gazetteer tablespace and user first before running this 
command.  If this is the case, follow the instructions from Step 1, but with a new 
tablespace name and user credentials for the gazetteer user.  You will also need to run 
the grants.cmd script for this new user. 

 
 After the script finishes, check the command window output for errors.  You should 

see “successfully created index” often.  There may be a few errors related to deleting 
tables that don’t exist.  You can ignore those errors. 

 
Now that the data is loaded, you must index the tables so that the gazetteer can be searched.  

 
 Set your working directory in the command line window to the directory that houses 

the index command called “aimsmetaindx.exe”.  It is located under your <ArcIMS 
Installation Directory>\Metadata\Commands folder. 
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 Index the gazetteer data by typing "aimsmetaindx.exe <sde_server_machine> 

<sde_instance> <database> <username> <password> {table_name_prefix} {logfile} 
{indexNew | indexAll} {localcodepage}". 
 
example: aimsmetaindx <sde_server_machine> <sde_instance> # 
<username> <password> gazetteer # # # 

 
o By default, the table_name_prefix is “gazetteer”.  Make sure that in your 

case, it is the same as the 8th parameter of the gazImport command you ran 
above. 

o The last 3 parameters are optional.  You can leave them out, or put # # # in 
their place. 

o After the aimsmetaindx.exe file runs, it will ask you to check the log file 
to verify that all documents were successfully created.  You will find the 
log file in the “Commands” directory and the filename is 
“aimsmetaindx.log”.  The log should read something similar to “[<Date>  
<Time>] [<numbers> <numbers> INFO1] Indexed successfully” 

 
 Proceed to Step 8b. 

 
 
Step 8b: Creating the Gazetteer Metadata Service 
 
Now that you have loaded the gazetteer data into the database, you will create an ArcIMS 
gazetteer service that will point to the loaded data. 

 
 Open the C:\ArcIMS\Axl\Metadata\Gazetteer.axl file. 

 
 Update the following text to match your machine's configuration: 

 
<SDEWORKSPACE name="sde0" server="<your machine name>" 
instance="port:5151" database="" user="<user name>" password="<password>"/> 
 
Note: If you are running your database on another port, update the port accordingly.  
 
Note: The user name and password correspond to the user that owns the tablespace 
into which you loaded the gazetteer data.  

 
 Uncomment the line where the <CONFIG_PARAMETER> has its keyword set to 

IMS_GAZETTEER 
 

 Save the Gazetteer.axl file and close it. 
 

 Now, create a metadata service called Gazetteer: 
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 Open the ArcIMS Administrator. Start>All 
Programs>ESRI>ArcGIS>ArcIMS>Administrator 
 

 Choose the Service menu and select New. 
 

 Enter the Service Name “Gazetteer”.   
 

 Enter the Source AXL File (e.g., C:\ArcIMS\Axl\Metadata\Gazetteer.axl). 
 

 Select the Virtual Server from the drop down menu (MetadataServer1). 
 

 Save the ArcIMS site configuration and exit Administrator. File>Save Configuration. 
 
 

 
Step 9: Restart Tomcat 
 
You have made many changes, but they will not go into effect until you restart Tomcat.  
 

 Open the Services panel. Start>Administrative Tools>Services. 
 

 Highlight Apache Tomcat and select the Restart Service tool from the toolbar. You 
can also right-click on Apache Tomcat and select Restart. 

 
Step 10: Run ArcIMS Diagnostics 
 
To verify the configuration changes, you need to test the ArcIMS diagnostics.  
 

 Open the ArcIMS Diagnostics.  
Start>All Programs>ESRI>ArcGIS>ArcIMS>Diagnostics 
 

 Click the number 1 box to Check the ArcIMS Servlet Connector. You can view your 
Diagnostic Results at the bottom of the page. 

 
 Click the number 2 box to Check ArcIMS Application Server. You can view your 

Diagnostic Results at the bottom of the page. 
 
Note: If ArcIMS diagnostics fails, restart ArcIMS services (in the following order: turn off 
ArcIMS Tasker, turn off ArcIMS Monitor, turn off ArcIMS Applications; then turn on 
ArcIMS Applications, turn on ArcIMS Monitor, and turn on ArcIMS Tasker). 
 
Note: If an ArcIMS Error 005 is returned, you need to verify your JDBC configuration and 
settings. 
 

 Additionally, connect to ArcIMS from ArcCatalog to view the metadata services 
created.  Make sure that there is a “write” or “pencil” icon on the 
TOOLKIT_Publish_Metadata service. 
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3.2 Database Installation for SQL Server Users 
 
Steps 1 and 2 below are for new GPT 3.1 installs only.  If you are migrating an 
existing GPT 3.0 database to GPT 3.1, skip to Step 3. 

 
Step 1: Deleting Old Tables 
 
In this step and step two, you will set up the database that will be used for the ESRI GIS 
Portal. The ESRI GIS Portal should run in its own schema or database. You will be using a 
SQL script to set up the database and a user for the portal using the names provided below.  
These values are sample values, but can be set to different values if necessary for your portal 
implementation. For example, SQL Server 2005 users need to set a different password than 
“meta” because by default SQL Server 2005 requires strong passwords containing numbers 
and/or special characters.  When you choose different values than “meta”, you will need to 
alter this value in some of the configuration files: 
 

 Database Name: meta 
 Database User: meta 
 Database User Password: meta 
 Example Database User Password for SQL Server 2005: m1e2t3a 

 
Note: If you have an existing instance of a database called “meta” that is no longer in use, 
please delete this database before running the new scripts. Failure to do so may result in not 
being able to create metadata services. Follow these steps to delete an existing “meta” 
database: 
 

 Delete the TOOLKIT_META tables from the old install using ArcCatalog. 
 Delete the “meta” database using the SQL Server Enterprise Manager. 

 
Step 2:  Creating the ESRI GIS Portal Toolkit Database Using the Script 
 
The SQL script for creating the GPT schema is called “create_toolkit_schema.cmd” and 
assumes that SQL Server has been installed under C:\Program Files\Microsoft SQL 
Server\MSSQL for SQL Server 2000 and C:\Program Files\Microsoft SQL 
Server\MSSQL.1\MSSQL for SQL Server 2005.   The portal database MDF file is hard-
coded to be created under these directories in the “\data\meta_log”. If you installed SQL 
Server in a different folder or would like to create the portal database in a different location 
on your machine then you must edit the path in the script before running the script file. 
 
To accept the default filepaths and proceed: 
 

 Open a command window. Start>Run>cmd. 
 For SQL Server 2000, change the directory to <CDROM>\supporting files\Database 

Scripts\SQLServer.  For SQL Server 2005, change the directory to 
<CDROM>\supporting files\Database Scripts\SQLServer_2005. 

 For SQL Server 2000, run the script create_toolkit_schema.cmd and for SQL Server 
2005, run the script create_toolkit_schema_05.  Use the following parameters: 
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o Usage : Create_toolkit_schema [DBServer] [Database] [GPTUserLogin] 
[GPTUserPwd] [SDEUser] 

 
Where 
o [DBServer] is the SQL Server Name. 
o [Database] is Portal database. 
o [GPTUserLogin] is Portal user. 
o [GPTUserPwd] is Portal password. 
o [SDEUser] is the SDE user. 
 

Sample input for SQL Server 2000: 
Create_Toolkit_Schema.cmd gpt4 meta meta meta sde 

 
Sample input for SQL Server 2005: 

Create_Toolkit_Schema_05.cmd gpt4 meta meta m1e2t3a sde 
 

 When the script finishes executing, you will be returned back to the command 
prompt.  Check the command prompt window for a possible message of “Building 
Database Failed” to indicate if something went wrong during script execution. 

 
 Review the build_schema.log, build_sp.log, and build_ft.log files and ensure that you 

do not get any error messages. Error messages and warnings, which state that Table 
or view does not exist, can be ignored. It simply means that the script was trying to 
delete a nonexistent table.  

 
The SQL scripts insert several records into the tables. These tables can be created under a 
different SQL Server user; that is, they do not have to belong to the same user as the 
metadata tables. This depends on the database policy defined by the client. Normally, the 
system database account does not own application tables, so a separate account is created. 
Note that these are not the same accounts as when connecting to the portal. The accounts 
mentioned here (and above) are necessary to set up the databases. 

 
 Open SQL Server Enterprise Manager or Management Studio and refresh the Databases 

folder from the table of contents. The meta database should be present. 
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Step 3:  GPT 3.0 to GPT 3.1 migration 
 
This step is intended only for those users who are migrating a GPT 3.0 Portal database to a 
GPT 3.1 database.   
 
Running migrate_v30v31_sqlserver.sql 
 
You must have an existing GPT 3.0 database in order to run this script.  It will not work with 
GPT 2.x databases.  The migrate_v30v31_sqlserver.sql script will update your existing GPT 
3.0 database to a GPT 3.1 database.   
 

 Open a command window. Start>Run>cmd 
 

 Change directory to <CDROM>\supporting files\Database Scripts\SqlServer 
 

 Run the script Update_toolkit_schema.cmd using the following parameters: 
 

o Usage : Update_toolkit_schema [DBServer] [Database] [GPTUserLogin] 
[GPTUserPwd] [SDEUser] 

 
Where 
 
o [DBServer] is the SQL Server Name. 
o [Database] is Portal database. 
o [GPTUserLogin] is Portal user. 
o [GPTUserPwd] is Portal password. 
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o [SDEUser] is the SDE user. 
 
Sample input: 
 

Update_toolkit_schema.cmd  MyMachine MyDatabase meta meta sde 
 

 Tip: There are a few more steps involved in migrating a GPT 3.1 instance, but they have to 
be done after the GPT application is deployed, in the  next section. 

 
Step 4: Verify Database Permissions for SQL Users 
 
In this step of the database configuration, you will set database ownership. 
 

 For SQL Server 2000: 
• Open SQL Server Enterprise Manager if not already open. 
• Open the Security folder and select Logins. 
• Right-click the meta login from the right-hand pane and choose Properties. 
• Select the Database Access tab.  
• In the list of databases, check the box next to the sde database and select 

db_owner in Database roles for sde (see graphic below). 
• Similarly, grant db_owner privileges to sde user for meta database. 
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 For SQL Server 2005: 
• Open SQL Server Management Studio if not already open. 
• There is a Security folder in the main catalog tree just below the 

“Databases” folder, and also separate Security folders under each database 
when you expand their nodes (ex: you click “Databases”, then “meta”, and 
there will be a Security folder under the meta directory). Open the 
Security folder that is NOT under your meta database, but is just below the 
first “Databases” folder. 

• Select Logins. 
• Right-click the meta login from the right-hand pane and choose Properties. 
• Select the User Mapping option on the left (see graphic below). 
• In the “Mapped to this login” window, check the box next to the “sde” 

database and “meta” database. 
• In the “database role membership” window, check the box next to “db-

owner”. 
• Click OK. 
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Step 5: Verify a Connection to the “meta” Database with ArcCatalog 
 

 Start ArcCatalog 
 Add a spatial database connection 
 Server: Your machine 
 Port: 5151 
 Database: meta. 
 User: meta 
 Password: meta (or whatever password you set in Step 1) 

 
 Click “test connection”. If the button becomes unavailable after a few moments, then 

the connection was successful. If the connection was unsuccessful, make sure your 
ArcSDE Service has been started. Go to the “services” menu under your “computer 
management” options in the “administrative tools” section of your computer’s control 
panel, and manually start the service. 
 

 Click OK. 
 

 Exit ArcCatalog. 
 
If you can see a list of tables in the meta database, then you have successfully connected to 
the database. 

 
If at some point during the installation, the database becomes corrupt and you 
need to remove your metadata tables, use ArcCatalog instead of SQL Server to 
do so.  

 
Step 6: Creating/Verifying and Indexing Full-Text Catalogs 
 A full-text catalog stores and searches your catalog content.  It is important that the content is 
kept up to date. After you create/verify the full-text catalog, you will enable SQL Server to 
automatically update it. 
 
First, you will verify that all required full-text catalogs are present.  If they are not, then you must 

create these catalogs. 
 

 In SQL Server Enterprise Manager (2000) or Management Studio (2005), open the meta 
database. 

 
 Click Full-Text Catalogs (2000) or click “Storage” then Full-Text Catalogs (2005). 

 
 Verify that two full-text catalogs are present. 
 

o SDE_DEFAULT_CAT 
o Portal 

 
If the catalogs are not present, follow these steps to create a new full-text catalog. 
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 Right-click Full-Text Catalogs under the meta database and click New Full-Text Catalog. 
 

 
 

 Type "SDE_DEFAULT_CAT" in the Name field. 
 

 Click OK. 
 

 Repeat these steps to create the Portal catalog as well. 
 

Note that you can change the location of the full-text catalog by clicking the Location button. 
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Starting the SQL Server Agent Services 
 SQL Server Agent is a Microsoft Windows service that executes scheduled 
administrative tasks, and you will use it to regularly update – or “index” – your full-text 
catalogs. 
 

 In SQL Server Enterprise Manager (2000), click Management. For SQL Server 2005, 
in the Object Explorer Window in Management Studio there is a node below 
“Notification Services” that says “SQL Server Agent”. 

 
 Right-click SQL Server Agent. 

 
 Click Start. 

 
 When it asks if you are sure you want to start the SQL Server Agent service on your 

computer, say “yes”. 
 
Indexing SQL Server Full-Text Catalogs 
 
Indexing enables faster metadata searches in the GIS Portal Toolkit. In the screenshots 
below, SQL Server 2000 is shown to the left and Server 2005 to the right. 
 

 In SQL Server 2000 Enterprise Manager select the meta database on your machine 
and click Full-Text Catalogs.  For SQL Server 2005 Management Studio, click meta, 
then Storage, then Full-Text Catalog. 

 

 
 

 On the right panel, double-click Portal. The Full-Text Catalog Properties-Portal 
dialog box will appear. 
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 SQL Server 2000: 
• Click the Schedules tab and click New Catalog Schedule. 
• Type an indexing name in the Name text box (e.g., Portal-Indexing). 
• Under Job type, choose Full population. 
• Choose Recurring under Schedule frequency and click Change. 
• Make changes as suggested in the table that follows. 

 SQL Server 2005:  
• Click the Population Schedule heading in the left window. Click “New” at 

the bottom of the window. 
• Type an indexing name in the Name text box (e.g., Portal-Indexing). 
• Under Schedule type, choose Recurring. 
• Under Frequency, make changes as suggested in the table that follows. 

 
Name Value 
Occurs Daily 
Daily Every “1” day(s) 
Daily Frequency Occurs every “5” Minutes 
Duration Start date: Yesterday’s date 
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 Leave the remaining values set to default and click OK to close the dialog box. 
 

 Click OK to close the New Full-Text Indexing Catalog Schedule dialog box. 
 

 In SQL Server 2000, click OK to close the Full-Text Catalog Properties-Portal dialog 
box and finish this step. 

 
 In SQL Server 2005, there are a couple additional steps before exiting the Full-Text 

Catalog Properties-Portal dialog box (see graphic below): 
 

• Click “Tables/Views” in the “Select a Page” window at the left. 
• In the “Table/View objects assigned to the catalog” box, highlight the 

ASEARCHXMLDOC file. 
• Click on the “automatic” radial button at the bottom of the box under 

“Track Changes”. 
• Click OK to close the Full-Text Catalog Properties box and finish. 
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Step 7: Setting Up Metadata Services 
 
In this step, you will create and configure two metadata services required for the GIS Portal 
Toolkit; these metadata services are used to browse and publish metadata. 
 

 Copy the AXL files below from <CDROM>\supporting files\AXL\sqlserver to the 
C:\ArcIMS\Axl directory on your local computer. 
 
o Toolkit_browse_metadata.axl 
o Toolkit_publish_metadata.axl 

 
Using Notepad, make the following changes to the AXL files for the Browse and Publish 
metadata services: 

 
 Edit the following SDEWORKSPACE tag attributes to match values for your system: 

server, instance, database, user name, and password. Note that the database attribute 
is optional for Oracle but required for SQL Server. For example: 
 
<SDEWORKSPACE name="sde-1" server="<database>" 
instance="port:<sdePort#>" database="" user="<user name>" 
password="<password>" /> 
 

 In both files, verify the table prefix for the metadata services, the default is 
TOOLKIT_META. You need to verify this table prefix does not already exist in the 
database. If the prefix already exists, you can either use a different prefix such as 
TOOLKIT_META1 or delete the existing TOOLKIT_META use ArcCatalog or 
ArcSDE. 

 
<TABLE_NAME prefix="TOOLKIT_META" /> 
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Next, create two metadata services (TOOLKIT_Browse_Metadata and 
TOOLKIT_Publish_Metadata) in ArcIMS Administrator using these AXL files. The 
service parameters are listed in table 3-3. 

 
 Open the ArcIMS Administrator.  

Start>All Programs>ESRI>ArcGIS>ArcIMS>Administrator 
 

 Choose the Service menu and select New. 
 

 Enter the Service Name (e.g., TOOLKIT_Browse_Metadata) *Note:  ArcIMS is case-
sensitive.  Enter the service name exactly as it is specified in Table 3-3 

 
 Enter the Source AXL File (e.g., C:\ArcIMS\Axl).  

 
 Select the Virtual Server from the drop down menu (e.g., MetadataServer1). 

 
 Repeat the steps above until you create a Service for both the 

TOOLKIT_Browse_Metadata and the TOOLKIT_Publish_Metadata files. 
 

 
Table 3-3 

ESRI GIS Portal Toolkit Metadata Service Names 
 

Service Name Source AXL File Service Type 
TOOLKIT_Browse_Metadata Toolkit_browse_metadata.axl Metadata Service 
TOOLKIT_Publish_Metadata Toolkit_publish_metadata.axl Metadata Service 

 
 Verify that the map service names in ArcIMS Administrator match those you created 

above: TOOLKIT_Browse_Metadata and TOOLKIT_Publish_Metadata. 
 

 Save the site configuration in ArcIMS Administrator. File>Save Configuration. 
 
When setting up the services, the metadata service generates a root document. To verify that 
the configuration of the metadata services is correct, compare the content and DOCUUID of 
the root document in the two locations. 
 

 Open SQL Server Enterprise Manager. 
 

 Open the meta database. 
 

 Click tables. 
 

 Open the TOOLKIT_Meta table. 
 

 Open the ASEARCHXMLDOC table. 
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 Compare the DOCUUID of the root document in the two tables.. 

 
If the DOCUUIDs are the same, you can proceed with installation of ESRI GIS Portal 
Toolkit. If not, you must remove the metadata tables using ArcCatalog and re-create the 
metadata services. You could delete the table using the SQL Server Enterprise Manager, but 
you will also need to remove records from the SDE database and table. With ArcCatalog, this 
is automatically done for you. 
 
After running the create_toolkit_schema script and setting up the metadata services, a large 
number of tables have been created. Table 3-4 below lists the created tables and the source of 
the creation (script or ArcIMS). Start ArcCatalog and verify that these tables have been 
created. 
 

Table 3-4 
GIS Portal Database Tables 

 

# Table Created By Description 
1 APUBLISHOUTPUTS Script Deprecated table.  Not used. 
2 APUBLISHRESULTS Script Deprecated table.  Not used. 
3 ASEARCHXMLDOC Script Type of address specified in a 

user’s profile. 
4 TOOLKIT_ADDRESSTYPE Script Channels in the portal. 
5 TOOLKIT_CHANNELS Script Channel history records. 
6 TOOLKIT_CHANNELS_HISTORY Script Channel stewards 
7 TOOLKIT_CHANNELUSERS Script Members of a metadata security 

policy group. 
8 TOOLKIT_GROUP_MEMBERS Script Types of members of groups 
9 TOOLKIT_GROUP_MEMBERTYPES Script Metadata security policy groups 

10 TOOLKIT_GROUPS  History of each repository’s 
harvest 

11 TOOLKIT_HARVEST_HISTORY Script Metadata repositories 
12 TOOLKIT_HARVESTING Script Type of address specified in a 

user’s profile. 
13 TOOLKIT_MAPSERV_PERM Script Stores all the individual 

authentication rules for each 
ArcIMS service. 

14 TOOLKIT_META ArcIMS Business table associated with 
the metadata service's feature 
class.  Contains one record for 
each folder or document. 

15 TOOLKIT_METAD ArcIMS Records which documents have 
been deleted from the metadata 
service. 

16 TOOLKIT_METADR ArcIMS Records which relationships no 
longer exist in the metadata 
service. 

17 TOOLKIT_METAR ArcIMS Stores the relationships between 
documents, folders, and the 
metadata service. 
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# Table Created By Description 
18 TOOLKIT_METAU ArcIMS Stores the names of all users 

who have sent requests to the 
metadata service users. 

19 TOOLKIT_MV_COORDSYS Script List of coordinate 
systems/projections eligible to 
be used by Map Viewer. 

20 TOOLKIT_MV_LINKS Script Saved user maps created when 
saving map “as a link”. 

21 TOOLKIT_MV_SAVED Script Saved user maps. 
22 TOOLKIT_MV_SERVICES Script Map services that have been 

accessed with the MapViewer. 
23 TOOLKIT_PUBPOLICY_ACCESSCODES Script The various states for setting a 

publisher’s policy. 
24 TOOLKIT_PUBPOLICY_MEMBERS Script Members of a given publisher’s 

policy 
25 TOOLKIT_SEARCHCRITERIA Script Saved user search criteria. 
26 TOOLKIT_SEL_CHNLUSERS Script Stewards for all channels 
27 TOOLKIT_USERS Script The authentication database's 

users table. The users table 
stores all the user names and 
passwords. 

28 TOOLKIT_USERS_ROLES Script The various roles a user can 
have. 

 
 The preloaded default values for selected key database tables are listed at the end of this 
section. 
 
Step 8: JDBC Authentication (Esrimap_Prop) 
 
As part of setting up the metadata services for ESRI GIS Portal Toolkit, the Esrimap_prop 
file must be modified to work with JDBC connectors. 
 

 Open the Esrimap_prop file in Notepad, which is located in your Tomcat home 
installation (e.g., C:\<Tomcat install directory>\webapps\servlet\WEB-
INF\classes\Esrimap_prop). 

 
 Modify the file to use the JDBC permission tables. Each of the parameters below 

must be updated to the specified values.  For each parameter that is preceded with a 
“#”, you must remove this character so as to ‘uncomment’ the parameter, thereby 
enabling it. 
o enable=True 
o appServerMachine=<localhost name> 
o appServerClientPort=5300 
o failover=False 
o debug=False 
o authenticate=True 
o authMethods=Basic 
o useJdbc=True 
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o jdbcDriver= net.sourceforge.jtds.jdbc.Driver 
o jdbcUrl=jdbc:jtds:sqlserver://<Database Server Name>:1433/meta 
o jdbcuser=meta 
o jdbcpassword=meta 
o jdbcpermtable=TOOLKIT_MAPSERV_PERM 
o jdbcusertable=TOOLKIT_USERS 
o jdbcuidcolumn=USERID 
 
Note: If SQL Server was installed with a named instance, the jdbcURL variable 
needs to have a different format. (The deviation is italicized) 
jdbc:jtds:sqlserver://<Database Server Name>:1433/meta;instance=sqlserver_jou01 

 
For further instructions on how to define extra parameters when configuring the 
jdbcURL parameter, refer to: http://jtds.sourceforge.net/faq.html#urlFormat  
 

 Copy the SQL Server JDBC driver (jtds-1.2.2.jar) to <Tomcat install 
dir>\webapps\servlet\WEB-INF\lib. The driver can be downloaded from 
http://jtds.sourceforge.net/. 

 
Step 9: Gazetteer Metadata Service 
 
ESRI GIS Portal Toolkit utilizes a gazetteer service for place-name lookup and defined 
spatial search extents. In this step, you will load the gazetteer, and then create a gazetteer 
metadata service. Loading the gazetteer requires running an ArcIMS .bat command which 
references gazetteer data. You may use the default gazetteer data provided on the ArcIMS 
gazetteer CD or use data of your own.  
 
For more details, see the Creating and Using Metadata Services document. 
 
Step 9a: Loading the Gazetteer  
 
To load the gazetteer, follow the instructions below according to your version of ArcIMS. 
 

 Go to “Services” and make sure that your ArcSDE Service (esri_sde) has been 
started.  

 
 Open the command prompt Start>Run>cmd 

 
ArcIMS 9.1:  

 
 Navigate to the location of the gazetteer import .bat file (GazetteerImport.bat), found 

at: <ArcIMS Installation Directory>\Metadata\Data\Gazetteer\ 
 

 Type "GazetteerImport <sde_server_name> <sde_instance_port> <username> 
<password> database".  The script can take a while to run, so be patient. 
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Note: The user name and password parameters reference the user who will own the 
gazetteer tables. This could be the SDE user, the meta user, or you may decide to 
separate the gazetteer data out into its own database, in which case it would be your 
new “gazetteer” user.  Should you decide to create the gazetteer in its own database, 
you will have to create the gazetteer database and user first before running this 
command.   

 
 After the script finishes, check the command window output for errors.  You should 

see “successfully created index” often.  There may be a few errors related to deleting 
tables that don’t exist.  You can ignore those errors. 

 
Now that the data is loaded, you must index the tables so that the gazetteer can be searched.  
 

 Start a full population on the full-text SDE_DEFAULT_CAT index in the gazetteer 
database to index the newly inserted data.  

 
 Proceed to Step 9b. 

 
 
ArcIMS 9.2: 

 
 Navigate to the location of the gazetteer import script (gazImport.bat), found at: 

<ArcIMS Installation Directory>\Metadata\Gazetteer\ 
 

 Type "gazImport sqlserver <sde_server_name> <sde_instance_port> <database> 
<username> <password> # gazetteer <path to gazetteer data>".   

 
o The “#” sign indicates that you are accepting a default value, and is 

considered one of the parameters to the script. 
 
o If you are using default ArcIMS gazetteer data and you have copied it into 

the same directory as the gazImport command, the parameter for the “path 
to gazetteer data” will be “gazworld92” or “gazusa92”.  If this data resides 
elsewhere, make sure to precede the data name with the absolute path to 
the data. (i.e. C:\myData\gazetteerData\gazworld92) 

 
o The script will take awhile to run, so be patient. 

 
Note: The user name and password parameters reference the user who will own the 
gazetteer tables. This could be the SDE user, the meta user, or you may decide to 
separate the gazetteer data out into its own database, in which case it would be your 
new “gazetteer” user.  Should you decide to create the gazetteer in its own database, 
you will have to create the gazetteer database and user first before running this 
command.   

 



 
3.0:  Windows-Based Portal Database Installation Installation Guide for GIS Portal Toolkit 3.1 

 
 

 
 

October 2007 3-31 
 

 After the script finishes, check the command window output for errors.  You should 
see “successfully created index” often.  There may be a few errors related to deleting 
tables that don’t exist.  You can ignore those errors. 

 
Now that the data is loaded, you must index the tables so that the gazetteer can be searched.  
 

 Start a full population on the full-text SDE_DEFAULT_CAT index in the gazetteer 
database to index the newly inserted data.  

 
 Proceed to Step 9b. 

 
Step 9b: Creating the Gazetteer Metadata Service 
 
Now that you have loaded the gazetteer data into the database, you will create an ArcIMS 
gazetteer service that will point to the loaded data. 

 
 Open the C:\ArcIMS\Axl\Metadata\Gazetteer.axl file. 

 
 Update the following text to match your machine's configuration: 

 
<SDEWORKSPACE name="sde0" server="<your machine name>" 
instance="port:5151" database="<database name>" user="<gazetteer username>" 
password="<gazetteer password>"/> 
 
Note: If you are running your database on another port, update the port accordingly.  
 
Note: The user name and password correspond to the user that owns the database into 
which you loaded the gazetteer data.  

 
 Uncomment the line where the <CONFIG_PARAMETER> has its keyword set to 

DEFAULTS 
 

 Save the Gazetteer.axl file and close it. 
 

 Now, create a metadata service called Gazetteer: 
 

 Open the ArcIMS Administrator. Start>All 
Programs>ESRI>ArcGIS>ArcIMS>Administrator 
 

 Choose the Service menu and select New. 
 

 Enter the Service Name “Gazetteer”.   
 

 Enter the Source AXL File (e.g., C:\ArcIMS\Axl\Metadata\Gazetteer.axl). 
 

 Select the Virtual Server from the drop down menu (MetadataServer1). 
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 Save the ArcIMS site configuration and exit Administrator. File>Save Configuration. 
 
 
Step 10: Restart Tomcat 
 
The final step in this section is to restart the servlet engine. You have made many changes, 
but they will not go into effect until you restart Tomcat. 
 

 Open the Services panel. Start>Administrative Tools>Services. 
 

 Highlight Apache Tomcat and select the Restart Service tool from the toolbar. You 
can also right-click on Apache Tomcat and select Restart. 

 
Step 11: Run ArcIMS Diagnostics 
 
To verify the configuration changes, you need to test the ArcIMS diagnostics.  
 

 Open the ArcIMS Diagnostics.  
Start>All Programs>ESRI>ArcGIS>ArcIMS>Diagnostics 
 

 Click the number 1 box to Check the ArcIMS Servlet Connector. You can view your 
Diagnostic Results at the bottom of the page. 

 
 Click the number 2 box to Check ArcIMS Application Server. You can view your 

Diagnostic Results at the bottom of the page. 
 
Note: If ArcIMS diagnostics fails, restart ArcIMS services (in the following order: turn off 
ArcIMS Tasker, turn off ArcIMS Monitor, turn off ArcIMS Applications; then turn on 
ArcIMS Applications, turn on ArcIMS Monitor, and turn on ArcIMS Tasker). 
 
Note: If an ArcIMS Error 005 is returned, you need to verify your JDBC configuration and 
settings. 
 

 Additionally, connect to ArcIMS from ArcCatalog to view the metadata services 
created.  Make sure that there is a “write” or “pencil” icon on the 
TOOLKIT_Publish_Metadata service. 

 
Default Values Loaded in Key Database Tables  
 
The following is an excerpt from create_toolkit_schema.sql: 
 
TOOLKIT_ADMIN USERS 
 
(USERNAME, PASSWORD) VALUES ('admin','admin') 
 
TOOLKIT_USERS 
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(USERID, USERNAME) VALUES (1, '*'); 
(USERID, USERNAME, PASSWORD, ROLEID) VALUES (2, 'author','author',0); 
(USERID, USERNAME, PASSWORD, ROLEID) VALUES (3, 'admin','admin',0); 
(USERID, USERNAME, PASSWORD, ROLEID) VALUES (4, 'gazetteer','gazetteer',0) 
 
TOOLKIT_MAPSERV_PERM 
 
(USERID, SERVICE, ACTIVE, ROLES) VALUES 
(1,'TOOLKIT_Browse_Metadata',1,'metadata_browser_all'); 
(USERID, SERVICE, ACTIVE, ROLES) VALUES (2,'*',1,'Metadata_service_author'); 
(USERID, SERVICE, ACTIVE, ROLES) VALUES 
(3,'TOOLKIT_Publish_Metadata',1,'metadata_administrator'); 
(USERID, SERVICE, ACTIVE) VALUES (1,'*',1); 
(USERID, SERVICE, ACTIVE) VALUES (1,'TOOLKITMap',1) 
 
 
End 
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4.0: Setting Up the GIS Portal Application 
 
4.1 Installation 
 
All database users (including DB2, Oracle, and SQL Server) must follow steps 1–7.  
 
Step 1: Copy the WAR Files 
 
In this step, you will copy the Portal.war and arcexplorer.war files from the source location to 
the <Tomcat installation folder>\webapps location. While Tomcat is running, the WAR files 
will automatically open and the content extracted into the appropriate directories: 
 

The Portal.war file will automatically open and extract in:  
<Tomcat installation dir>\ webapps\Portal 
 
The arcexplorer.war file for Map Viewer will automatically open and extract in:  
<Tomcat installation dir>\webapps\arcexplorer 

 
 Open Windows Explorer. 

 
 Navigate to the \Portal folder on the CD-ROM. 

 
 Copy the Portal.war and arcexplorer.war files. 

 
 Paste the WAR files in <Tomcat installation dir>\webapps. 

 
 After a few moments, verify that two directories named Portal and arcexplorer were 

created in webapps.  
 

 Tip: You may need to refresh Windows Explorer to see the Portal and arcexplorer 
directory, or you may need to restart Tomcat to deploy the war files.  

 
 Create a folder called c:/toolkit31. This folder will be used to store logs and validated 

metadata records, and provide a default data upload location. 
 

 
Step 2: Copying the JAR Files 
 
In this step, you will configure the GIS Portal Toolkit framework and copy all the required 
Portal JAR files to the <Tomcat installation dir>\webapps\Portal\WEB-INF\lib directory and 
all of the required MapViewer JAR files to the <Tomcat installation 
dir>\webapps\arcexplorer\WEB-INF\lib.  The Portal\WEB-INF\lib and arcexplorer\WEB-
INF\lib directories may already contain some JAR files.  You will copy additional files into 
these directories. Do NOT delete the files that are already there. 
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Below is a list of JAR files required to install the GIS Portal and the Map Viewer. Note that 
the JAR files below are taken from Section 2. Refer to Section 2 for the download locations of 
the following JAR files. 
 

Table 4-1 
Third-Party Libraries 

  Vendor JAR 
  Portal Database Libraries – you only need the ones that are appropriate to your database 
1 Oracle 9i/10g JDBC Driver ojdbc14_g.jar 
2 IBM DB2 driver db2jcc.jar 
3 IBM DB2 driver db2jcc_license_cu.jar 
4 SourceForge JTDS jtds-1.2.2.jar 
  Portal Libraries  
1 Sun JAF activation.jar 
2 ESRI arcims_jconnect.jar 
3 Apache Axis axis.jar 
4 Apache Axis axis-ant.jar 
5 Apache Commons Beanutils commons-beanutils.jar 
6 Apache Commons Collections commons-collections-3.1.jar 
7 Apache Commons DBCP commons-dbcp-1.2.1.jar 
8 Apache Commons Digester commons-digester.jar 
9 Apache Commons Discovery commons-discovery.jar 
10 Apache Commons Fileupload commons-fileupload-1.0.jar 
11 Apache Commons Lang commons-lang-2.0.jar 
12 Apache Commons Logging commons-logging.jar 
13 Apache Commons Pool commons-pool-1.2.jar 
14 Apache Commons Validator commons-validator.jar 
15 ESRI esri-translator.jar 
16 ESRI isglobal.jar 
17 Apache Axis jaxrpc.jar 
18 Unknown junit.jar 
19 ESRI jxcb.jar 
20 Apache Axis log4j-1.2.8.jar 
21 Sun JavaMail mail.jar 
22 Apache Axis saaj.jar 
23 Apache Struts struts.jar 
24 Apache Velocity velocity-dep-1.3.1.jar 
25 Apache Axis wsdl4j-1.5.1.jar 
26 Apache Xalan xalan.jar 
27 Apache Xalan xercesImpl.jar 
28 Apache Xalan xml-apis.jar 
      
  MapViewer Database Libraries – you only need the ones that are appropriate to your database 
1 Oracle 9i/10g JDBC Driver ojdbc14_g.jar 
2 IBM DB2 driver db2jcc.jar 
3 IBM DB2 driver db2jcc_license_cu.jar 
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  Vendor JAR 
4 SourceForge JTDS jtds-1.2.2.jar 
  Map Viewer Libraries   
1 Apache Batik batik-awt-util.jar 
2 Apache Batik batik-bridge.jar 
3 Apache Batik batik-css.jar 
4 Apache Batik batik-dom.jar 
5 Apache Batik batik-ext.jar 
6 Apache Batik batik-extension.jar 
7 Apache Batik batik-gvt.jar 
8 Apache Batik batik-parser.jar 
9 Apache Batik batik-script.jar 
10 Apache Batik batik-svg-dom.jar 
11 Apache Batik batik-transcoder.jar 
12 Apache Batik batik-util.jar 
13 Apache Batik batik-xml.jar 
14 Apache Commons commons-dbcp-1.2.1.jar 
15 Apache Commons commons-fileupload-1.0.jar 
16 Apache Commons Collections commons-collections-3.1.jar 
17 Apache Commons Pool commons-pool-1.2.jar 
18 ESRI esriCWebDbAuth.jar 
19 ESRI iscore.jar 
20 ESRI isother.jar 
21 Sun Microsystems jai_core.jar 
22 Sun Microsystems jai_codec.jar 
23 Apache Axis log4j-1.2.8.jar 
24 Apache Xalan xercesImpl.jar 
25 Apache Xalan xml-apis.jar 
 
 
Step 3: Configuring Tomcat for JNDI 
 
The GIS Portal uses Java Naming and Directory (JNDI) to access resources from the GIS 
Portal Toolkit; therefore, the Web application container (Tomcat) needs to be configured for 
JNDI use from the Portal and arcexplorer applications. 
 
The Tomcat Web application container needs to be aware of the properties of the JNDI data 
resources. The resources could be shared or unique to each Web application deployed with 
the container.  

 
 Navigate to the <CDROM>\supporting files\Configuration files directory. 

 
 If you are using Oracle, you will be working with the “Portal_Ora_Tomcat.txt” file 

that corresponds to your Tomcat version (5.0.28 or 5.5.17). If you are using SQL 
Server, you will be working with the “Portal_SQLServer_Tomcat.txt” file that 
corresponds to your Tomcat version (5.0.28 or 5.5.17).  
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 Copy this file into the Tomcat\conf\Catalina\localhost directory 

 
 Rename the text file to “Portal.xml” – note the capitalization of Portal! 

 
 Open the file in Notepad. 

 
 Update the <Database_Server_Name> and <Database_Instance_Name> (Oracle) or 

<Database_Name> (SQLServer) to reflect your database server and database 
(instance) names. 

 
 Save the file and close it. 

 
 Navigate to the <CDROM>\supporting files\Configuration files directory. 

 
 If you are using Oracle, you will be working with the “arcexplorer_Ora_Tomcat.txt” 

file that corresponds to your Tomcat version (5.0.28 or 5.5.17). If you are using SQL 
Server, you will be working with the “arcexplorer_SQLServer_Tomcat.txt” file that 
corresponds to your Tomcat version (5.0.28 or 5.5.17). 

 
 Copy this file into the Tomcat\conf\Catalina\localhost directory. 

 
 Rename the text file to “arcexplorer.xml” 

 
 Open the file in Notepad. 

 
 Update the <Database_Server_Name> and <Database_Instance_Name> (Oracle) or 

<Database_Name> (SQLServer) to reflect your database server and database 
(instance) names. 

 
 Save the file and close it. 

 
 

Step 4: Restart Tomcat 
 

In this section thus far you have deployed the WAR files and configured your JNDI.  You 
must now restart Tomcat for the changes to take effect.  
 

 Open the Services panel. Start>Administrative Tools>Services. 
 

 Highlight Apache Tomcat and select the Restart Service tool from the toolbar. You 
can also right-click on Apache Tomcat and select Restart. 
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Step 5: Configuring the GIS Portal and Map Viewer 
 
In this step, you will run the portal configuration wizard. This wizard will update the required 
configuration files for you. 
 

 Open a Web browser. 
 

 Enter the following URL: "http://<machine name>:<port>/Portal/config.do" to open 
the configuration wizard. 

 

 
 

 Enter the Portal administrator user name "default = admin". 
 

 Enter the Portal administrator password "default = admin". 
 

 Read the license agreement, then click the “I accept the license” button. 
 

 Click Login. 
 
If the login is not successful, check the database connection in the <resource> part of the 
Portal.xml file or the arcexplorer.xml file located in <Tomcat installation dir>\ conf\ 
Catalina\localhost. 
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On the Architecture dialog box, you will need to specify the names of the machines you are 
using.  
 
In a classroom install, the names of these two machines are the same. However, in a typical 
production environment, it is possible that all three components are installed on different 
machines. 
 
Enter the following information: 
 

 Web Server: Name of the Web server that hosts your Tomcat installation. (e.g. the 
machine name on which Tomcat is installed.) 

 
 Port: Enter the port number that Tomcat is using. 

 
 ArcIMS application server: Name of the machine on which the ArcIMS application 

server that you use for ArcIMS metadata services and image services is installed.  
 

 Click Submit and continue to Step 1. 
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On the Configure Portal Properties dialog box, you will enter basic information such as a 
work folder name, mail server address and an email address of the person who will 
receive the Portal’s feedback form. 
  

 
 
 

 Work folder: This is the folder that the GIS Portal uses to store log files and validated 
metadata and is a default location for uploaded metadata.  Enter in the name of the 
folder you created at the end of Step 1 (e.g., c:/toolkit31) 
 
IMPORTANT:  You must specify the path name with forward slashes (“/”) 

 
 Mail Server: This is the address of your mail server that will be used to send email 

from the Portal to the specified feedback email address. 
 

 Feedback Email Address: This is the email address of the person who is to receive all 
feedback submissions from the Portal site. 

 
 Click Submit and continue to Step 2. 
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On the Configure Portal ArcIMS Services dialog box, you will specify map services that 
your GIS Portal and Map Viewer will use.  
 

 
 

 For the Portal Base Map Service, select PortalBaseMap from the drop down menu. 
 

 For the Portal Search Map Service, select PortalSearchMap from the drop down 
menu. 

 
 For the Portal Acetate Map Service, select the PortalAcetateMap from the drop dowm 

menu. 
 

 For the Gazetteer Service, select Gazetteer from the drop down menu. 
 

 Click Submit and continue to Step 3. 
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On the Configure Map Viewer Properties dialog box, you will specify the output directory 
that the GIS Portal Map Viewer uses to store the merged images that are served to the end 
user. This could be any directory, but it is good practice to use the ArcIMS output path and 
URL. 
 
 

 
 

 Enter an Output Path, which is a folder on the local system where ArcIMS will store 
the generated maps.  
 
IMPORTANT:  You must specify the path name with forward slashes (“/”) 

 
 Enter an Output URL, which is the URL equivalent to the output path.  

 
 (Optional) Enter a DDE URL. This is the URL to your Data Delivery Extension 

service.  
 

 (Optional) Enter a Tool tip for DDE Link. A Tool tip for DDE Link is a tip that is 
displayed when users hover over the data download button.. 

 
 Click Submit and continue to Step 4. 
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On the Configure JDBC Authentication dialog box, you will fill in the required JDBC 
connection parameters to reflect your system information. 
 

 
 
It is best to copy and paste these values directly out of the esrimap_prop file that you 
modified in Section 3.  
 

 Enter the Driver, which is the JDBC driver  
(e.g. jdbcDriver=oracle.jdbc.driver.OracleDriver) 
(e.g., jdbcDriver=net.sourceforge.jtds.jdbc.Driver) 

 
 Enter the URL, which is the JDBC URL  

(e.g., jdbcUrl=jdbc:oracle:thin@<DB Server Name>:1521: <DB instance name>). 
(e.g., jdbcUrl=jdbc:jtds:sqlserver://<DB Server Name>:1433/<DB Name>). 

 
 Enter a User Name for the database user (default = meta). 

 
 Enter the Password for the database user above (default = meta). 

 
 (For Oracle database users only) Select the Use Thesaurus drop down menu to 

specify whether you want your Portal to offer a thesaurus. 
 

 Click Submit to Finish. 
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The last screen of the configuration wizard is the Installation Report, which shows the status 
of your installation. An example is provided below. 
 

 
 
Step 6: Copy the Updated Files 
 
The updated configuration files must be copied to the correct locations.  

 For the Portal application, copy the following files from C:\toolkit31\config\portal to 
<Tomcat installation dir>\webapps\Portal\WEB-INF\classes: 

 
o Authenticate.properties 
o log4j.properties 
o catalogconfig.xml 
o ptk.xml 



 
4.0  Setting Up the GIS Portal Application Installation Guide for GIS Portal Toolkit 3.1 

 
 

 
 

October 2007 4-12 
 

 
 For the Map Viewer, copy the following files from C:\toolkit31\config\arcexplorer to 

<Tomcat installation dir>\webapps\arcexplorer\WEB-INF\classes: 
 

o ArcExplorerWeb.properties 
 

 Tip: Example configuration files are provided at the end of this section for each of the 
files listed in this step. Use these example files to troubleshoot your installation (if required). 
 
Step 7: Modify the Tomcat Configuration Files 
 
If your Web Server is Internet Information Services (IIS) 6.0 
 

 Open the uriworkermap.properties file in notepad located in <Tomcat installation 
directory>\conf. 

 
 Add the following entries: 

 
/Portal/*=wlb 
/Portal=wlb 
 
/arcexplorer/*=wlb 
/arcexplorer=wlb 
 

 Save the file and exit. File>Save. 
 
 

If your Web Server is Apache 2.0.58 
 

 Open in notepad the mod_jk.conf file located in the <Tomcat installation 
directory>\conf folder. 

 
 Add the following entries: 

 
JkMount /Portal ajp13 
JkMount /Portal/* ajp13 
 
JkMount /arcexplorer ajp13 
JkMount /arcexplorer/* ajp13 
 

 Save the file and exit. 
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Step 8: Restart 
 
Now that you have configured all the required files, you need to restart Tomcat and 
IIS/Apache to activate these changes. 

 
 Open the Services panel. Start>Control Panel>Administrative Tools>Services. 

  
 Restart the Web Server on your system (e.g., Apache or IIS). 

 
 Restart Tomcat. 

 
Step 9: Testing the Portal Framework 
 
After Tomcat has restarted, you are ready to do a few basic verification tests of the Portal 
application. 
 

 Start your Web browser and enter the following URL: http://<machine name>/Portal 
 

 The GIS Portal Toolkit home page opens.  
 

 Tip: If the portal home page does not appear, try typing in the URL with the Tomcat 
port, for example, http://<machine name>:8080/Portal. If the portal home page appears, then 
the restart of Tomcat did not result in all desired changes. You may need to restart the IIS 
services for the new application redirects to work. If the IIS/Apache services fail to restart, 
reboot your computer. 

 
 Once you see the home page, click the Advanced Search link to open the Advanced 

Search page. 
 

 Zoom in on the search map by clicking a location or drawing a search area on the 
search map.  

 

 Tip: If nothing happens or you get a broken image, check your settings for the 
ArcIMS image service. You may need to restart Tomcat and your Web server. 
 

 Next, login to the Portal as the administrator. Enter the user name and password for 
the administrator, typically "admin/admin" to login to the Portal as the administrator. 
A successful login verifies that your database connections are configured correctly. 
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Step 10: Running the Portal Health Check 
 
The Portal Health Check page is a quick verification script that checks the following: 
 

1. Connectivity to the database, by attempting to execute a query against the 
ASEARCHXMLDOC table. 

 
2. Ability to query the TOOLKIT_Browse_Metadata service. 

 
3. Access to the TOOLKIT_Publish_Metadata service. 

 
Run the Portal Health Check: 
 

 Type the following URL in your browser: 
http://<machine name>/Portal/jsp/Admin/healthCheck.jsp 

 
 If everything is ok, you should get a page simply stating “OK”. 

 

 Tip: If you get an error, the following sequence of service restarts should fix most 
problems.  Do not proceed to use the Portal until the health check reports OK. 
 

o Stop Tomcat 
o Stop your Web Server 
o Stop the ArcIMS services 
o Stop ArcSDE 
o Restart ArcSDE 
o Restart ArcIMS 
o Restart your web server 
o Restart Tomcat.  

 
 
4.2 Additional Configuration Steps for Users Migrating GPT 3.0 Database 

to GPT 3.1 (Oracle & SQLServer) 
 
By running the migration scripts in Section 3, the old GPT 3.0 database schema has been 
altered to account for database changes needed for GPT 3.1.  Next, you need to update the 
existing data that is already present in your tables to match the format needed for GPT 3.1 
 
To do this update, GPT 3.1 comes with a new JSP page that performs the necessary 
migration steps. 
 

 Open the Portal homepage. http://<machine name>/Portal 
 

 Log in as the Portal Administrator with the username and password admin/admin. 
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 In the URL of the browser, type: 
http://<GPT machine name>/Portal/ jsp/Admin/migrateV30V31.jsp  

 
 Once on the page, click the “Migrate Records” button to update the existing data that 

is already present on your tables to match the format needed for GPT 3.0. 
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Example Configuration Files 
 
Authenticate.properties 
 
# Enables authentication of requests processed by the ArcIMS Java Connector. 
# Authentication allows restrictions to be placed on access to ArcIMS Services. 
# True or False. 
authenticate=true 
 
# Set this to True if you desire additional debug information to be logged 
debug=False 
 
# Path and filename to the Access Control List file. Only used when 
authenticate=True. 
# aclFileName=aimsacl.xml 
#aclFileName=aimsacl.xml 
 
# The useJdbc property enables authentication using JDBC.  True of False. 
# Only used when authenticate=True. 
useJdbc=true 
 
# Name of the JDBC driver to be used.  Only used when authenticate=True and 
# useJdbc=True.  Example:  jdbcDriver=zyh.sql.dbf.DBFDriver 
jdbcDriver=oracle.jdbc.driver.OracleDriver 
 
# JDBC database URL to the database that contains the permissions and users 
# table.  Only used when authenticate=True and useJdbc=True. 
# jdbc:oracle:<database name>:@<machine name>.<domain>.<organizational code> 
jdbcUrl=jdbc:oracle:thin:@10x:1521:ora10x 
 
# Authentication databases username.  Only used when authenticate=True and 
# useJdbc=True.  Example:  jdbcUser=user1 
jdbcUser=meta 
 
# Authentication databases password.  Only used when authenticate=True and 
# useJdbc=True.  Example:  jdbcPassword=password1 
jdbcPassword=meta 
 
# Name of the authentication databases permissions table.  The permissions 
# table stores all of the individual authentication rules for each ArcIMS Service. 
# Only used when authenticate=True and useJdbc=True. 
jdbcPermTable=TOOLKIT_MAPSERV_PERM 
 
# Name of the authentication databases users table. The users table stores all 
# of the user names and passwords.  Only used when authenticate=True and 
# useJdbc=True. 
jdbcUserTable=TOOLKIT_USERS 
 
# Name of the userid column found in both the permissions and users tables. 
# The userid column is the unique identifier between the users and permissions 
# tables.  Only used when authenticate=True and useJdbc=True. 
jdbcUidColumn=USERID 
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Log4j.properties 
 
# Attach appender A1 to root. 
# 
# Note: 
# Logging levels in order of priority are: 
ALL;DEBUG;INFO;WARN;ERROR;FATAL;OFF 
# 
log4j.rootLogger=ERROR, A1 
 
#log4j.appender.A1=org.apache.log4j.FileAppender 
log4j.appender.A1=org.apache.log4j.DailyRollingFileAppender 
log4j.appender.A1.File=C:/toolkit31/logs/global.log 
 
#log4j.appender.A1.Threshold=ERROR 
# Truncate 'global.log' if it aleady exists. 
log4j.appender.A1.Append=false 
 
log4j.appender.A1.layout=org.apache.log4j.PatternLayout 
log4j.appender.A1.DatePattern='.' yyyy-MM-dd 
log4j.appender.A1.layout.ConversionPattern=%-6p [%t] %c{2} (%M:%L) - %m%n 
 
#Configure 'CONSOLE' logger 
log4j.appender.CONSOLE=org.apache.log4j.ConsoleAppender 
log4j.appender.CONSOLE.layout=org.apache.log4j.PatternLayout 
log4j.appender.CONSOLE.layout.conversionPattern=%-6p %m%n 
 
log4j.logger.ptk=error, gptapp 
log4j.appender.gptapp=org.apache.log4j.RollingFileAppender 
log4j.appender.gptapp.File=C:/toolkit31/logs/portal_root.log 
log4j.appender.gptapp.Threshold=ERROR 
log4j.appender.gptapp.MaxFileSize=1MB 
log4j.appender.gptapp.MaxBackupIndex=1 
log4j.appender.gptapp.layout=org.apache.log4j.PatternLayout 
log4j.appender.gptapp.layout.ConversionPattern=[%d][%t %c %p] %m%n 
 
log4j.logger.ptk_admin=error, ptkapp 
log4j.appender.ptkapp=org.apache.log4j.RollingFileAppender 
log4j.appender.ptkapp.File=C:/toolkit31/logs/ptk_admin.log 
log4j.appender.ptkapp.Threshold=ERROR 
log4j.appender.ptkapp.MaxFileSize=1MB 
log4j.appender.ptkapp.MaxBackupIndex=1 
log4j.appender.ptkapp.layout=org.apache.log4j.PatternLayout 
log4j.appender.ptkapp.layout.ConversionPattern=[%d][%t %c %p] %m%n
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Catalogconfig.xml 
 
<?xml version="1.0" encoding="UTF-8"?> 
<catalog xsi:schemaLocation="http://www.esri.com/apps/catalog/catalog-
service ogc_catalog.xsd"> 
 
<cs:catalog-discovery> 
 

<ds:DBConfig> 
<ds:jndiName>jdbc/gisportal</ds:jndiName> 

</ds:DBConfig> 
 
 <ds:MetadataSearch> 

<ds:MetadataIndexTableName>ASearchXMLDoc</ds:MetadataIndexTableName> 
  <ds:MetadataResultSortUserInterface> 

gpt.searchAdvanced.sortResultsItems.Date;gpt.searchAdvanced.sortR
esultsItems.Title;gpt.searchAdvanced.sortResultsItems.AreaAsc;gpt
.searchAdvanced.sortResultsItems.AreaDesc 

</ds:MetadataResultSortUserInterface> 
 

<ds:MetadataResultSortOrderClause> 
Metadata_update DESC;Name ASC;Area ASC;Area DESC 

</ds:MetadataResultSortOrderClause> 
</ds:MetadataSearch> 

 
 <ds:MetadataResult> 

<ds:MetadataResultTableName>APublishResults</ds:MetadataResultTableN
ame> 

<ds:MetadataOutputTableName>APublishOutputs</ds:MetadataOutputTableN
ame> 
</ds:MetadataResult> 

 
 <ds:ResultSettings> 

<ds:RecordsPerPage>15</ds:RecordsPerPage> 
<ds:RecordsPerQuery>500</ds:RecordsPerQuery> 

</ds:ResultSettings> 
</cs:catalog-discovery> 
 
<cs:catalog-publish> <!-- schemas supported by the Publisher Service --> 
 
 <schemas> 

<schema name="fgdc" schemaValidationLevel="off"/> 
<schema name="iso19115" schemaValidationLevel="off"/> 
<schema name="iso19139" schemaValidationLevel="off"/> 
<!-- To enable schema validation for ISO19139 Metadata Profile 
replace this line 

        <schema name="iso19139" schemaValidationLevel="off"/> 
        with this 

<schema name="iso19139" schemaValidationLevel="error"  
schemaLocation="http://www.isotc211.org/2005/gmd 
http://www.isotc211.org/2005/gmd/metadataEntity.xsd"/>     
--> 

</schemas> 
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<publish-validate>false</publish-validate> 
<publish-log-to-tables>false</publish-log-to-tables> 

 
 <publish-output> 

<output-name>VALIDATED</output-name> 
<output-description>Output Validated XML to Disk</output-

description> 
<output-writer>VALIDATED</output-writer> 
<output-writer>TOOLKIT_Publish_Metadata</output-writer> 
<output-writer>dbwriter</output-writer> 

</publish-output> 
 
<publish-writer name="TOOLKIT_Publish_Metadata" url="http://10x" 

type="ARCIMS"/> 
 
 <publish-writer name="dbwriter" type="database" default="true"> 
 
  <DBConfig> 

<ds:jndiName>jdbc/gisportal</ds:jndiName> 
</DBConfig> 

</publish-writer> 
 
 <publish-writer name="VALIDATED" type="folder"> 

<writer-folder>c:/toolkit31/valid/validated</writer-folder> 
<writer-prefix>validated</writer-prefix> 
<writer-suffix>xml</writer-suffix> 

</publish-writer> 
</cs:catalog-publish> 
</catalog>
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Ptk.xml 
 
<?xml version="1.0" encoding="UTF-8"?> 
 
<PtkParams xsi:schemaLocation="http://www.esri.com/apps/ptk-service 
portalToolkit.xsd"> 
 
<DBConfig> 
 <DBConnection> 
 <!--  JNDI datasource must be configured in the container; for Tomcat 
in server.xml and web.xml --> 

<jndiName>jdbc/gisportal</jndiName> 
</DBConnection> 

 
 <DBSchema> 

<PtkUsersTN>TOOLKIT_USERS</PtkUsersTN> 
<PtkUsersSN>TOOLKIT_USER_ID_SEQ</PtkUsersSN> 
<PtkMapservPermTN>TOOLKIT_MAPSERV_PERM</PtkMapservPermTN> 
<PtkSaveSearchTN>TOOLKIT_SEARCHCRITERIA</PtkSaveSearchTN> 
<PtkSaveSearchSN>TOOLKIT_SEARCHCRITERIA_SEQ</PtkSaveSearchSN> 
<PtkTextSearchTN>ASEARCHXMLDOC</PtkTextSearchTN> 
<PtkSavedMapTN>TOOLKIT_MV_SAVED</PtkSavedMapTN> 
<PtkLinksMapTN>TOOLKIT_MV_LINKS</PtkLinksMapTN> 
<PtkMetadataTablePrefix>TOOLKIT_META</PtkMetadataTablePrefix> 
<PtkMetadataAdminTN>asearchxmldoc</PtkMetadataAdminTN> 
<PtkHarvestingTN>TOOLKIT_HARVESTING</PtkHarvestingTN> 

  <!-- this is used by metadata synchronizer for SQL server only --> 
<PtkSQLServerDBName>META</PtkSQLServerDBName> 
<PtkHarvestHistoryTN>TOOLKIT_HARVEST_HISTORY</PtkHarvestHistoryTN> 

</DBSchema> 
</DBConfig> 
 
<ArcIms> 

<PtkImsImageService>PortalSearchMap</PtkImsImageService> 
<PtkImsImageServer>http://10x</PtkImsImageServer> 
<PtkImsImageServerUsername/> 
<PtkImsImageServerPassword/> 
<PtkImsBrowseMetaService>TOOLKIT_Browse_Metadata</PtkImsBrowseMetaServi

ce> 
<PtkImsPublishMetaService>TOOLKIT_Publish_Metadata</PtkImsPublishMetaSe

rvice> 
<PtkImsMetaServer>10x:5300</PtkImsMetaServer> 
<PtkImsUseAppServerBroker>n</PtkImsUseAppServerBroker> 
<PtkImsAdminUsername>admin</PtkImsAdminUsername> 
<PtkImsBatchLimit>25</PtkImsBatchLimit> 
<PtkImsVelocityLogFile>c:/toolkit31/logs/MetadataAdminVelocity.log</Ptk

ImsVelocityLogFile> 
<PtkMetadataSyncFreqnency>120</PtkMetadataSyncFreqnency> 
<!-- unit: minutes, put -1 if syn is not needed --> 

</ArcIms> 
 
<Search> 

<PtkMaxSavedSearches>10</PtkMaxSavedSearches> 
<PtkMaxSearchResults>10</PtkMaxSearchResults> 
<PtkSearchMapWidth>250</PtkSearchMapWidth> 
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<PtkSearchMapHeight>185</PtkSearchMapHeight> 
<PtkSearchMapMaxx>180</PtkSearchMapMaxx> 
<PtkSearchMapMaxy>90</PtkSearchMapMaxy> 
<PtkSearchMapMinx>-180</PtkSearchMapMinx> 
<PtkSearchMapMiny>-90</PtkSearchMapMiny> 
<PtkUseThesaurus>true</PtkUseThesaurus> 
<PTKThesaurusNames>Thesaurus_Test,NOAA_Short</PTKThesaurusNames> 
<PtkEnableViewWithArcGISExplorer>true</PtkEnableViewWithArcGISExplorer> 
<PtkEnableViewWithArcMap>true</PtkEnableViewWithArcMap> 

</Search> 
 
<Gazetteer> 

<!-- valid values are ArcIMS, ArcWeb--> 
<PtkGazetteerType>ArcIMS</PtkGazetteerType> 

 
<!-- PtkGazetteerServer: needed for ArcIMS type, this is the server 
name (with server:port or http://server:port) For ArcWeb, this is not 
needed --> 
<PtkGazetteerServer>http://10x</PtkGazetteerServer> 

 
 <!-- PtkGazetteerServiceName is the service name for ArcIMS, 
 or data source name for ArcWeb, e.g. ESRI.Gazetteer.World--> 

<PtkGazetteerServiceName>Gazetteer</PtkGazetteerServiceName> 
<PtkGazetteerUsername/> 
<PtkGazetteerPassword/> 
<PtkGazetteerMaxRecords>50</PtkGazetteerMaxRecords> 

 
<!-- value of PtkUseArcwebSvcForGazetteer should be either true or 
false --> 
<PtkUseArcwebSvcForGazetteer>false</PtkUseArcwebSvcForGazetteer> 

</Gazetteer> 
 
<Geocoding> 

<!-- valid values are ArcWeb, OpenLS, --> 
<PtkGeocodingType>ArcWeb</PtkGeocodingType> 

 
<!-- PtkGeocodingServer: For Open LS, this is the server URL e.g 
http://www.arcwebservices.com/services/v2006/servlet/LBSConnector.           
For ArcWeb, this is not needed --> 
<PtkGeocodingServer>http://arcweb.esri.com/services/v2/AddressFinder</P

tkGeocodingServer> 
 
 <!-- PtkGeocodingServiceName is the service name for ArcIMS, 

or the service group for OpenLS, eg. XLS.TA.US, or data source name for 
ArcWeb, e,g. GDT.Streets.US --> 
<PtkGeocodingServiceName>GDT.Streets.US</PtkGeocodingServiceName> 
<PtkGeocodingUsername/> 
<PtkGeocodingPassword/> 

</Geocoding> 
 
<MapViewer> 

<ArcExplorerDomainPfx>http://10x:8150</ArcExplorerDomainPfx> 
<PtkBaseMapUrl>http://10x</PtkBaseMapUrl> 
<PtkBaseMapSvc>PortalBaseMap</PtkBaseMapSvc> 

</MapViewer> 
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<Context> 

<EncriptionKey>PtkESRI</EncriptionKey> 
<Max_SavedMaps>10</Max_SavedMaps> 
<RecordsPerPage>25</RecordsPerPage> 
<UploadFileAllowed>TXT,txt,XML,xml,SGML,sgml</UploadFileAllowed> 
<UploadSizeLimit>2000000</UploadSizeLimit> 
<MailServer>firewire.esri.com</MailServer> 
<FeedbackToEmail>portal@esri.com</FeedbackToEmail> 
<LoginLength>5</LoginLength> 

</Context> 
 
</PtkParams>
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ArcExplorerWeb.properties 
 
# 
# 
# ArcExplorerWeb properties 
# 
# 
 
# send debug messages to std out 
debug=false 
 
# Specify font which will be used y ArcIMS to generat legend 
#legend.font=<FontName> 
 
# merged images need to go somewhere ... 
# outputurl=http://<host>/output/ 
outputpath=C:/ArcIMS/Output 
outputurl=http://localhost/output/ 
 
# store links and saved maps in flat files or in any JDBC compliant 
database tables with Blob support 
# use storagetype=Oracle to save in any database 
# storagetype=[file|Oracle] 
storagetype=Oracle 
jndi_name=jdbc/arcexplorer 
 
# Basemap 
basemap.name=GIS Portal Toolkit Basemap 
basemap.server=http://10x 
basemap.servertype=0 
basemap.service=PortalBaseMap 
basemap.username= 
basemap.password= 
basemap.logo=basemap_logo.gif 
 
# Copyright text 
map.copyright= 
 
# Number of maps each user is allowed to save to portal database 
maxsavedmaps=10 
 
# saved maps need to go somewhere ... 
# savepath=C:/<workDir>/saved/ 
savepath=C:/toolkit31/saved/ 
 
# the login servlet should really run on an https server and the main 
servlet on an http server 
# the main servlet then needs to know how to call the login servlet 
# 
secure_servlet_name=http://<host>/arcexplorer/servlet/ArcExplorerWeb_Login 
secure_servlet_name=http://10x:8150/arcexplorer/servlet/ArcExplorerWeb_Log
in 
 
# Place Finder URL 
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placefinder_url=http://10x:8150/Portal/ptk?command=findplace.jsp&caller=ex
plorer 
 
# the login servlet should really run on an https server and the main 
servlet on an http server 
# the login servlet then needs to know how to call the login page from the 
main application 
returnpage=/arcexplorer/jsp/login.jsp 
 
# the projection to be used as default projection on the viewer 
# A valid projection id (integer) must be provided. Projection strings are 
no longer supported! 
# If not given, defaults to 4326 
projection.id=4326 
projection.available=4326:GCS_WGS_1984|4267:GCS_North_American_1927|4269:G
CS_North_American_1983|4135:GCS_Old_Hawaiian|32610:WGS_1984_UTM_Zone_10N|3
2611:WGS_1984_UTM_Zone_11N|32612:WGS_1984_UTM_Zone_12N|32613:WGS_1984_UTM_
Zone_13N|32614:WGS_1984_UTM_Zone_14N|32615:WGS_1984_UTM_Zone_15N|32616:WGS
_1984_UTM_Zone_16N|32617:WGS_1984_UTM_Zone_17N|32618:WGS_1984_UTM_Zone_18N
|32619:WGS_1984_UTM_Zone_19N|32620:WGS_1984_UTM_Zone_20N|32630:WGS_1984_UT
M_Zone_30N|102006:Alaska_Albers_Equal_Area_Conic|102007:Hawaii_Albers_Equa
l_Area_Conic|102008:North_America_Albers_Equal_Area_Conic|102010:North_Ame
rica_Equidistant_Conic|102009:North_America_Lambert_Conformal_Conic|102003
:USA_Contiguous_Albers_Equal_Area_Conic|102005:USA_Contiguous_Equidistant_
Conic|102004:USA_Contiguous_Lambert_Conformal_Conic 
 
# empty ArcIMS service used for projections and acetate images (needs one 
not visible layer) 
# local connections are better if possible 
# arcims.service=MyMapService 
# arcims.server=http://myMapServer.com 
# arcims.serverlocal=myMapMachine:5300 
arcims.service=PortalAcetateMap 
arcims.server=http://10x:8150 
arcims.serverlocal=10x:5300 
 
# ArcWeb login info, needed for PlaceFinder and AddressFinder 
# if you do not use ArcWeb service for place/address finder, comment them 
out or leave them blank 
# arcweb.username=<username> 
# arcweb.password=<password> 
#arcweb.username= 
#arcweb.password= 
# the coordinate system in which the place/address finder results are 
returned 
# must be a valid integer projection id accepted by ArcIMS 
placeAddressFinder.coordinateSystemId=4326 
 
#wms 
# Set prefered GetFeatureInfo response format for Identify features of WMS 
services 
# If not set the default format will be rendered from each WMS service 
# MIME types are supported (text/xml, text/html, text/plain) 
wms.infoFormat=text/xml 
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#wfs 
# Do not make this large for performance reasons 
wfs.maxfeatures=100 
wfs.maxFeaturesDefault=50 
# The values for color are expected to be valid SVG attributes values for 
fill and stroke; 
# linewidth is stroke-width. See SVG documentation. 
wfs.defaultFeatureLayerColor=red 
wfs.defaultFeatureLineWidth=0.96 
wfs.defaultLabelStyle=font-size:10;fill:black 
wfs.showLabels=false 
 
# DDE data download 
dde.orderformurl= 
dde.orderformtip= 
 
# table that contains service information (id, mapserver, mapservice) 
# so the url and service name don't need to be send with the URL all the 
time 
gpt.table.services=TOOLKIT_MV_SERVICES 
 
# table that tells us the map units for any projection 
gpt.table.coordsys=TOOLKIT_MV_COORDSYS 
 
# this is needed if we store saved maps and links in the database 
gpt.table.saved=TOOLKIT_MV_SAVED 
gpt.table.links=TOOLKIT_MV_LINKS 
gpt.table.mapservperm=TOOLKIT_MAPSERV_PERM 
gpt.table.users=TOOLKIT_USERS 
 
 
 End 
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5.0: Desktop Tools Installation  
 
5.1 Channel Editor  
 
This section of the installation guide provides you with basic installation instructions for the 
Channel Editor. Only those users assigned to manage a channel need to read this information.  
 
The Channel Editor desktop tool requires that Microsoft XML 4.0 be installed on the 
machine.  

 
 Ensure that you have Microsoft XML 4.0 installed on your machine. If you do not 

have Microsoft XML installed, download it from the following URL: 
http://www.microsoft.com/downloads/details.aspx?FamilyID=3144b72b-b4f2-46da-
b4b6-c5d7485f2b42&DisplayLang=en   

 
 If you do not know the version of Microsoft XML that is installed on your machine, 

search for "Microsoft XML version" in an Internet browser. You will find several 
online utilities that will be able to determine the Microsoft XML version that your 
machine has.  

 
 If necessary, install Microsoft XML 4.0.  

 
Now that you have confirmed the presence of Microsoft XML 4.0 on your machine, you can 
install the Channel Editor. 

 
 Open Windows Explorer.  

 
 Navigate to the Desktop Applications\ChannelEditor folder on the GIS Portal Toolkit 

CD-ROM.  
 
To install the Channel Editor, simply follow the instructions on the screen. There is no need 
to change any of the default values.  

 
 Double-click the setup.exe file. 

 
 The GIS Portal Channel Editor—Install Wizard will appear. 

 
 Click Next.  

 
 Click the button to the left of I accept the terms in the license agreement.  

 
 Click Next.  

 
The Customer Information dialog box will appear. On this dialog box, you define who owns 
and uses the software.  
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 Enter customer information in the User Name and Organization text boxes.  
 

 Under Install this application for, select Anyone who uses this computer (all users).  
 

 Click Next.  
 

 Click Next.  
 

 Click Install.  
 

 Click Finish to exit the installation program.  
 
You are now ready to use Channel Editor and update the key resources for the channels you 
have been assigned. 
 
5.2 Harvesting Tool  
 
This section of the installation guide provides you with basic installation instructions for the 
Harvesting tool. Only those users assigned to harvest metadata repositories need to read this 
information.  
 
Step 1a: Install ZMARCO (Optional)  
 
If you will be harvesting from a Z39.50 repository, you must first install a third-party 
software component called ZMARCO.  

 
 Open your Web browser.  

 
 Navigate to the following location: http://zmarco.sourceforge.net/.  

 
 Download ZMARCO to the temp folder on your machine.  

 
 Install ZMARCO by double-clicking the setup file.  

 
Step 1b: Install the Harvesting Tool  

 
 Open Windows Explorer.  

 
 Navigate to the Desktop Applications\HarvestingTool folder on the GIS Portal 

Toolkit CD-ROM.  
 

 Run setup.exe.  
 

 Follow the instructions on the screen.  
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5.3 GIS Portal Extensions for ArcGIS 
 
The GIS Portal Extensions for ArcGIS include the following three components: 

• CSW Client for ArcGIS Desktop 
• CSW Client for ArcGIS Explorer 
• WMC Opener for ArcMap  

 
The two CSW Clients are bundled together into a single installer that installs both the CSW 
Client for ArcGIS Desktop and the CSW Client for ArcGIS Explorer in one operation. The 
WMC Opener has its own installer. 
 

 Download the GIS Portal Extensions for ArcGIS from: 
http://www.esri.com/software/arcgis/extensions/gis-portal-extensions/index.html 
 

 Open Windows Explorer.  
 

 Navigate to the location where you saved the downloaded files. 
 

 Run setup.exe.  
 

 Follow the instructions in the wizard to carry out the installation.  
 
Note: During installation, the installer checks for the presence of the ArcGIS .NET 
framework as well as the present of at least Service Pack 2 for ArcGIS Desktop 9.2.  If either 
or both of these are not found, the CSW Client for ArcGIS Desktop will not be installed.  
However, installation will continue for CSW Client for ArcGIS Explorer, and a dialog box 
will appear notifying the user of the installation status. 
 

 
 
 
Adding the CSW Client to a Toolbar in ArcMap  
 

 Start ArcMap. 

 Click Tools and select “Customize” 

 Click on the “Commands” tab. 

 Scroll down through the list of Commands and highlight “GIS Portal Toolkit”. 
The “Find Services” icon will appear in the Commands window to the right.   
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 Highlight the icon and drag it to any empty space on any toolbar you wish. 

 Click Close. 

 
Enabling the CSW Client (Find Services Task) in ArcGIS Explorer 
 

 Open the ArcGIS Explorer application. Start>All Programs>ArcGIS>Explorer. 

 At the top of the page, click on the "Tools" menu and select "Manage Tasks". A "Manage 
Tasks" popup window will appear. 

NOTE: If a previous version of the CSW Client for ArcGIS Explorer was installed, you will 
need to first delete the “Find Services” task (it will be listed in the “All available tasks” pane) 
before navigating to the new “CSWSearchTask.CustomTaskUI.nmf” file. 
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 Click on “Get Tasks...” 

 Browse to the directory where the CSW Client files were installed. The default filepath is 
"C:\Program Files\ESRI\Portal\CswClients\". 

 Select the "CSWSearchTask.CustomTaskUI.nmf" file and click "Open". A download box 
appears. Click "Download". 

After the file has been downloaded into ArcGIS Explorer, the "Manage Tasks" window will 
have changed. It will now have the "Find Services" task listed in the left of the two boxes.  

 Highlight the "Find Services" task 

 Click on the arrow located between the two boxes. The "Find Services" task is added to 
the box on the right. 



 
5.0:  Desktop Tools Installation Installation Guide for GIS Portal Toolkit 3.1 

 
 

 
 

October 2007 5-6 
 

 
 

 Click "OK" to close the Manage Tasks window. 

Notice that the "Find Services" task is now listed at the bottom of the Tasks menu.  
 Click on the arrow to the far right of the Find Services task and select "Activate" to open 

it. 

 



 
5.0:  Desktop Tools Installation Installation Guide for GIS Portal Toolkit 3.1 

 
 

 
 

October 2007 5-7 
 

Displaying “Find Services” in the Default Map at Startup 
 
If you want to have the CSW Client loaded into the default “Tasks” window upon loading 
ArcGIS Explorer, the current settings must be saved.  
 
To save the current settings: 
 

 Click on the File menu and select “Save As”. 

 Navigate to the ArcGIS Explorer\Maps folder on the local machine, usually located at 
C:\Documents and Settings\<user_name>\My Documents\ArcGIS Explorer 
Documents\Maps. 

 Save the map as “default.nmf”. 

 
 

 Go to “Tools”, and select “Options”.  

Under the “Application\Startup” heading, there is a dialog that allows users to select what 
map should open by default when ArcGIS Explorer starts.  

 Select the “Open the map located at” radial button 

 Navigate to the “default.nmf” file that you just saved.  
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 Click OK.  

The next time you open ArcGIS Explorer, it will reference the “default.nmf” map, with the 
“Find Services” task already available. 
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Appendix A: Explanation of the Configuration Variables  
 
PTK.XML  

Variable  Description  
Database  
<jndiName>jdbc/gisportal</jndiName>  Name of the JNDI instance as defined in server.xml.  
<PtkUsersTN>TOOLKIT_USERS</PtkUsersTN>  Name of the GIS Portal Toolkit user table.  
<PtkUsersSN>TOOLKIT_USER_ID_SEQ</PtkUsersSN>  Table storing the sequence ID for users.  

<PtkMapservPermTN>TOOLKIT_MAPSERV_PERM</PtkMapservPermTN>  

Name of the table handling the map service access 
permissions for each user and service on the GIS 
portal machine.  

<PtkSaveSearchTN>TOOLKIT_SEARCHCRITERIA</PtkSaveSearchTN>  Table storing the search results.  
<PtkSaveSearchSN>TOOLKIT_SEARCHCRITERIA_SEQ</PtkSaveSearchSN>  Table storing the sequence ID for the search criteria.  
<PtkTextSearchTN>ASEARCHXMLDOC</PtkTextSearchTN>  Table used by GIS portal for full text search.  
<PtkSavedMapTN>TOOLKIT_MV_SAVED</PtkSavedMapTN>  Table used for storing saved maps.  
<PtkLinksMapTN>TOOLKIT_MV_LINKS</PtkLinksMapTN>  Table used for storing saved maps as URL (links).  

<PtkMetadataTablePrefix>TOOLKIT_META1</PtkMetadataTablePrefix>  
Prefix used by the GIS Portal Toolkit metadata 
services.  

<PtkMetadataAdminTN>asearchxmldoc</PtkMetadataAdminTN>  Administrative table used by GIS portal.  

<PtkHarvestingTN>TOOLKIT_HARVESTING</PtkHarvestingTN>  
Table used for storing the sites registered for 
harvesting.  

<PtkSQLServerDBName>META</PtkSQLServerDBName>>  SQL Server only: Name of the GIS portal database.  

<PtkHarvestHistoryTN>TOOLKIT_HARVEST_HISTORY</PtkHarvestHistoryTN>  
This is used by metadata synchronizer for SQL 
Server only.  

ArcIMS  

<PtkImsImageService>PortalSearchMap</PtkImsImageService>  
Name of the GIS portal search map. Must be in 
geographic.  

<PtkImsImageServer>http://ghoogeweg</PtkImsImageServer>  
Name of the ArcIMS service hosting the portal search 
map.  

<PtkImsImageServerUsername/>  
User name if the portal search map is a secure 
service.  

<PtkImsImageServerPassword/>  Password if the portal search map is a secure service. 

<PtkImsBrowseMetaService>TOOLKIT_Browse_Metadata</PtkImsBrowseMetaService>  
Name of the Browse metadata service. This name 
can be changed.  

<PtkImsPublishMetaService>TOOLKIT_Publish_Metadata</PtkImsPublishMetaService>  
Name of the Publish metadata service. This name 
can be changed.  

<PtkImsMetaServer>ghoogeweg:5300</PtkImsMetaServer>  ArcIMS server hosting the two metadata services.  
<PtkImsUseAppServerBroker>n</PtkImsUseAppServerBroker>  
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<PtkImsAdminUsername>admin</PtkImsAdminUsername>  Name of the GIS portal administrator.  

<PtkImsBatchLimit>25</PtkImsBatchLimit>  
Maximum number of documents you can batch 
publish at once.  

<PtkImsVelocityLogFile>c:/toolkit2/logs/MetadataAdminVelocity.log</PtkImsVelocityLogFile>  
Log file used by velocity. The path to this file must 
exist.  

<PtkMetadataSyncFreqnency>120</PtkMetadataSync Freqnency>  

Synchronization interval in minutes. Use only when 
you publish using ArcCatalog. Set to -1 if you do not 
want to synchronize.  

Search  
<PtkMaxSavedSearches>10</PtkMaxSavedSearches>  Maximum number of searches a user can save.  
<PtkMaxSearchResults>10</PtkMaxSearchResults>  Maximum number of maps a user can save.  
<PtkSearchMapWidth>250</PtkSearchMapWidth>  Width in pixels of the search map image.  
<PtkSearchMapHeight>185</PtkSearchMapHeight>  Height in pixels of the search map image.  

<PtkSearchMapMaxx>180</PtkSearchMapMaxx>  
Maximum extent of the search map. This is matched 
against the image size.  

<PtkSearchMapMaxy>90</PtkSearchMapMaxy>  
Maximum extent of the search map. This is matched 
against the image size.  

<PtkSearchMapMinx>-180</PtkSearchMapMinx>  
Minimum extent of the search map. This is matched 
against the image size.  

<PtkSearchMapMiny>-90</PtkSearchMapMiny>  
Minimum extent of the search map. This is matched 
against the image size.  

<PtkUseThesaurus>true</PtkUseThesaurus>  Oracle only: Set to yes if you are using a thesaurus.  

<PTKThesaurusNames>Thesaurus_Test,NOAA_Short</PTKThesaurusNames>  
Oracle only: Names of the thesaurus that you are 
using.  

<PtkEnableViewWithArcGISExplorer>true</PtkEnableViewWithArcGISExplorer>  

Whether the View with Globe button should appear in 
search results for metadata that is of type Live 
Service.  

<PtkEnableViewWithArcMap>true</PtkEnableViewWithArcMap>  
Whether the Add to ArcMap button should appear in 
search results.  

Gazetteer  

<PtkGazetteerType>ArcIMS</PtkGazetteerType>  

The gazetteer type. Valid values are "ArcIMS" or 
"ArcWeb" for when the gazetteer is to directly hit the 
ArcWeb Gazetteer service.  

<PtkGazetteerServer>http://ghoogeweg</PtkGazetteerServer>  
Name of the ArcIMS server hosting the gazetteer 
service.  

<PtkGazetteerServiceName>gazetteer</PtkGazetteerService>  Name of the gazetteer service.  
<PtkGazetteerUsername/>  Optional user name if the gazetteer service is secure.  
<PtkGazetteerPassword/>  Optional password if the gazetteer service is secure.  

<PtkGazetteerMaxRecords>50</PtkGazetteerMaxRecords>  
Maximum number of records returned by the 
gazetteer.  
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<PtkUseArcwebSvcForGazetteer>false</PtkUseArcwebSvcForGazetteer>  
Determines if you are using ArcWeb Services for your 
gazetteer. Set to True if you use ArcWeb Services.  

Geocoding  

<PtkGeocodingType>ArcWeb</PtkGeocodingType>  

The type of service to be used by the address search 
functionality. Valid values are "ArcWeb" and 
"OpenLS".  

<PtkGeocodingServer>http://arcweb.esri.com/services/v2/AddressFinder</PtkGeocodingServer> 

When the value of the Geocoding type is "OpenLS", 
the location of the server hosting the geocoding 
service.  

<PtkGeocodingServiceName>GDT.Streets.US</PtkGeocodingServiceName>  The name of the geocoding service.  

<PtkGeocodingUsername/>  
Optional user name if the geocoding service is 
secure.  

<PtkGeocodingPassword/>  Optional password if the geocoding service is secure.  
Map Viewer  

<ArcExplorerDomainPfx>http://[machineName]:[port]</ArcExplorerDomainPfx>  
Name of the server hosting your GIS portal Map 
Viewer.  

<PtkBaseMapUrl>http://[machineName]</PtkBaseMapUrl>  URL to the Map Viewer.  

<PtkBaseMapSvc>PortalBaseMap</PtkBaseMapSvc>  Name of the service used in the Map Viewer.  
Context  

<EncriptionKey>PtkESRI</EncriptionKey>  Internal key used for harvesting. Do not change.  

<Max_SavedMaps>10</Max_SavedMaps>  
Maximum number of maps users can have saved in 
their profile.  

<RecordsPerPage>25</RecordsPerPage>  
Maximum number of records to display on a search 
results page.  

<UploadFileAllowed>TXT,txt,XML,xml,SGML,sgml</UploadFileAllowed>  The file types that are allowed for a file upload.  

<UploadSizeLimit>2000000</UploadSizeLimit>  The maximum size of a file selected for file upload.  

<MailServer>firewire.esri.com</MailServer>  The mail server used to send the feedback form.  

<FeedbackToEmail>portal@esri.com</FeedbackToEmail>  
The e-mail address to which a submitted feedback 
form is sent.  

<LoginLength>5</LoginLength>  The minimum length allowed for a new user name.  
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CATALOGCONFIG.XML  
 

Variable  Description  
Database  
<ds:jndiName>jdbc/gisportal</ds:jndiName>  Name of the JNDI instance as defined in server.xml.  

<ds:MetadataIndexTableName>ASearchXMLDoc</ds:MetadataIndexTableName>  
Name of the table that is used by the full-text 
indexing.  

<PtkUsersSN>TOOLKIT_USER_ID_SEQ</PtkUsersSN>  Table storing the sequence ID for users.  

<PtkMapservPermTN>TOOLKIT_MAPSERV_PERM</PtkMapservPermTN>  

Name of the table handling the map service access 
permissions for each user and service on the GIS 
portal machine.  

<PtkSaveSearchTN>TOOLKIT_SEARCHCRITERIA</PtkSaveSearchTN>  Table storing the search results.  
<PtkSaveSearchSN>TOOLKIT_SEARCHCRITERIA_SEQ</PtkSaveSearchSN>  Table storing the sequence ID for the search criteria.  
<ds:MetadataResultSortUserInterface>gpt.searchAdvanced.sortResultsItems.Date; 
gpt.searchAdvanced.sortResultsItems.Title; gpt.searchAdvanced.sortResultsItems.AreaAsc; 
gpt.searchAdvanced.sortResultsItems.AreaDesc</ds:MetadataResultSortUserInterface>  

The text options of the sort drop-down list found on 
the advanced search page.  

<ds:MetadataResultSortOrderClause>Metadata_update DESC;Name ASC;Area ASC;Area 
DESC</ds:MetadataResultSortOrderClause>  

The values corresponding to the text for the sort drop-
down list found on the advanced search page.  

<ds:MetadataResultTableName>APublishResults</ds:MetadataResultTableName>  Table for storing metadata results.  
<ds:MetadataOutputTableName>APublishOutputs</ds:MetadataOutputTableName>  Table for storing publishing results.  
<ds:RecordsPerPage>15</ds:RecordsPerPage>  Maximum number of records to display on a search 

results page.  
 

<ds:RecordsPerQuery>500</ds:RecordsPerQuery>  Maximum number of records to retrieve in a single 
search query.  

<schema name="fgdc" schemaValidationLevel="off"/>  Parameters for supporting FGDC schema validation.  
<schema name="iso19115" schemaValidationLevel="off"/>  Parameters for supporting ISO 19115 schema 

validation.  
<schema name="iso19139" schemaValidationLevel="off"/>  Parameters for supporting ISO 19139 schema 

validation.  
<publish-validate>true</publish-validate>  True/False value for enabling/disabling content 

validation during publishing.  
<publish-log-to-tables>false</publish-log-to-tables>  Whether publishing logs should be written to the 

database.  
<output-name>VALIDATED</output-name>  The name of the output writer.  
<output-description>Output Validated XML to Disk</output-description>  Description of the output writer.  
<output-writer>VALIDATED</output-writer>  The name of the output file writer used by the 

publishing service.  
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<output-writer>TOOLKIT_Publish_Metadata</output-writer>  The name of the ArcIMS table writer used by the 
publishing service.  

<output-writer>dbwriter</output-writer>  The name of the GPT table writer used by the 
publishing service.  

<publish-writer name="TOOLKIT_Publish_Metadata" url="http://10x" type="ARCIMS"/>  Parameters of the ArcIMS table writer.  
<publish-writer name="dbwriter" type="database" default="true">  Parameters of the GPT table writer.  
<ds:jndiName>jdbc/gisportal</ds:jndiName>  Name of the JNDI instance as defined in server.xml.  
<writer-folder>c:/toolkit31/valid/validated</writer-folder>  Folder details for the "validated" output file writer.  
<writer-prefix>validated</writer-prefix>  Prefix for files written by the "validated" output file 

writer.  
<writer-suffix>xml</writer-suffix>  Suffix for files written by the "validated" output file 

writer.  

 


